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About this guide

Welcome to Qualys Cloud Platform! We'll show you how to use the Qualys Core and
Qualys VMDR applications.

About Qualys

Qualys, Inc. (NASDAQ: QLYS) is a pioneer and leading provider of cloud-based security and
compliance solutions. The Qualys Cloud Platform and its integrated apps help businesses
simplify security operations and lower the cost of compliance by delivering critical
security intelligence on demand and automating the full spectrum of auditing,
compliance and protection for IT systems and web applications.

Founded in 1999, Qualys has established strategic partnerships with leading managed
service providers and consulting organizations including Accenture, BT, Cognizant
Technology Solutions, Deutsche Telekom, Fujitsu, HCL, HP Enterprise, IBM, Infosys, NTT,
Optiv, SecureWorks, Tata Communications, Verizon and Wipro. The company is also a
founding member of the Cloud Security Alliance (CSA). For more information, please visit
www.qualys.com

Qualys Support

Qualys is committed to providing you with the most thorough support. Through online
documentation, telephone help, and direct email support, Qualys ensures that your
questions will be answered in the fastest time possible. We support you 7 days a week,
24 hours a day. Access support information at www.qualys.com/support/


https://cloudsecurityalliance.org/
www.qualys.com
http://www.qualys.com/support/
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Welcome to Qualys VMDR for ServiceNow

Qualys VMDR for ServiceNow application comprises of an application that manages
connection between ServiceNow and Qualys - Qualys Core. Once the connection is
configured, you can define import configurations, import schedules, incidents and related
event detection rules, and service-level agreement (SLA) definition in the Qualys Core
application. You can also configure detection rules for qualys-patchable vulnerabilities
that reflects in automatic creation of change requests, creation of patch jobs in Qualys
Patch Management. This helps in faster remediation and thus helps to meet the SLAs to
reduce risk within the organization.

Qualys VMDR

The Qualys VMDR is an application that manages tracking of open vulnerabilities and
mapping of remediation tickets to the respective resolver groups. The applications acts as
a bridge between Security and IT teams, and avoids manual intervention by creating
automated workflows.

Note: Both Qualys VMDR and the Qualys Core app are included with a Qualys
Vulnerability Management, Detection and Response (VMDR) 2.0 subscription.

For quick introduction to the Qualys Core and Qualys VMDR application, click here.

Key Features

- Bi-directional integration between Qualys and ServiceNow, where findings from Qualys
are pulled by ServiceNow and push mechanism that provides information on critical
vulnerabilities with real time mapping of threat indicators.

- Automated data import from Qualys VMDR, File Integrity Monitoring (FIM), and Patch
Management with predefined criteria- on demand or through a defined schedule.

Note: FIM incidents and related events can be configured from Qualys Core version
1.2.0 and later.

- Automated ticket creation, identification or matching of Cls with ServiceNowCMDB,
assignment to rightful owners, and closure on remediation.

- Vulnerability grouping based on multiple parameters, such as, operating system,
severity, Qualys TruRisk score, and so on. This helps in reducing number of tasks for the IT
teams to track and remediate.

- Custom SLA can be defined for open vulnerabilities based on Qualys real-time threat
indicators (RTIs) and Qualys VMDR 2.0 with TruRisk.

- Automated Change request creation, approval enforcement and integration with Qualys
patch management


https://vimeo.com/799796704
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- Integrated Exception Management and false positive process to offer a comprehensive
and complete VM solution.

- The rescan feature to measure the impact of patching. If the vulnerability is identified by
Qualys as Fixed, based on the outcome of the consecutive scan or agent data, the task will
be automatically closed.

- Dynamic dashboard and reports can be created to display data and status based on
status of vulnerability, SLA monitoring, critical assets with RTIs and Asset Risk Scoring.

Pre-requisites
- Service account with Manager privilege and API access in Qualys subscription

- ServiceNow IT Service Management (ITSM) test instance (recommended) and production
instance.

Note: Request an instance size based on the following guidelines:

e Instance size XL for less than 1 million vulnerabilities
e [nstance size XXL for 1 - 2.5 million vulnerabilities
e Instance size Ultra for more than 2.5 million vulnerabilities

- Up-to-date ServiceNow Configuration Management Database (CMDB) with reconciliation
process enabled for newly-identified assets

- Qualys Core and Qualys VMDR applications
Note: Qualys Core application is a prerequisite for installing Qualys VMDR.

- Qualys subscription with Vulnerability Management, Detection and Response (VMDR) 2.0
- Qualys FIM subscription

Note: Contact your ServiceNow representative to set up and install the applications
on a test instance first and then on the production instance.

User Roles and Permissions

The access to the Qualys Core and Qualys VMDR applications is restricted based on the
user roles.
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The following table presents the user groups and associated roles and permissions for

Qualys Core application:

Role

Permissions

x_qual5_core.admin

Administrative user of the application.
Create, Write, Read, and Delete access to all aspects of the
application.

x_qual5_core.kb_read

Read access to the Qualys - KnowledgeBase records.

x_qual5_core.create_ci_fro
m_host

Can see the "Create CI" Ul action from host records.

x_qual5_core.api_data_rece
iver

Grants access to any Data Receiver API Endpoints that are
available "globaly" across the Qualys for ServiceNow app and
add-ins. These endpoints are used for Pushing data from Qualys
into ServiceNow. This role would need to be given to the
ServiceNow Service Account that is being used by Qualys for API
Authentication.

# API Endpoints
/api/x_qual5_core/vl/data_receiver/{connector_sys_id}/vmdr/ho
st_asset
/api/x_qual5_core/vl/data_receiver/{connector_sys_id}/vmdr/ho
st_detection

x_qual5_core.connector_us
er

This role grants access to create, modify and delete Connector
Records.

x_qual5_core.qualys_fim_in
cident_user

Has access to FIM Incidents and information related to them.

x_qual5_core.general_settin
gs

Has access to read/write the General Settings values of the
application.

x_qual5_core.import_user

Has access to the import_set tables for debugging and API Calls.

x_qual5_core.host_user

Has Read access to Host Asset Records and related information
such as Asset Tags and Asset Groups

x_qual5_corelaunch_vm_s
can

Role required to see / interact with Launching VM Scans

x_qual5_core.patch_deploy
ment_user

This role grants access to view and management patch
deployments for Change Request

x_qual5_core.view_vm_sca
n

This role grants access to view VM Scans and related data such
as Option Profiles and Scanner Appliances
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Permissions

x_qual5_core.user

This role grants basic access to the Data Tables within Qualys
CORE and basic information within those tables. Typically this
role is not granted directly to users, and will be auto-granted
based on the add-on application roles that come with
Applications such as Qualys VMDR

# Access to read the following
- Qualys Tags / Asset Tags
- Detection Event Rules
- Specifically the Name, and Description attributes (and
nothing else)
- Qualys Asset Groups
- Basic Information to Connectors, such as Name.
- Access to ancillary functionality used by various functions of
other applications.

x_qual5_core.qualys_knowl
edgebase_user

This role grants READ Only access to the Qualys KnowledgeBase

The following table presents the user groups and associated roles and permissions for

Qualys VMDR application.
Role

Permissions

x_qual5_vmdr.dashboard_v
iewer

Can Access / View Dashboard from VMDR Application

x_qual5_vmdr.admin

Can create/read/write/delete items within this application
scope.

x_qual5_vmdr.exception_ap
prover

Can read vunlnerability tasks where they are the "Exception
approver" or if the task is assigned directly to them.

x_qual5_vmdr.false_positiv
e_approver

Has access to read Vulnerability Tasks where they are involved
in the approval process for it (regardless of which approval step).
Has additional access to edit fields required to be filled by the
False Positive Approver on the vulnerability task, when they are
involved in the approval for that vulnerability task.




Role

Qualys VMDR for ServiceNow
Welcome to Qualys VMDR for ServiceNow

Permissions

x_qual5_vmdr.remediation_
owner

This is the role intended for Remediation Owners that need to
perform work on VMDR Task or VMDR Task Group records that
belong to a Support/Assignment group that they are a member
of.

## VMDR Task

- Grants Read/Write access to VMDR Tasks and Related
Functions where the logged in user is a member of the
Assignment Group for that Task

## VMDR Task Group

- Grants Read/Write access to VMDR Task Group Records and
Related Functions where the logged in user is a member of the
Assignment Group for that Task

x_qual5_vmdr.vulnerability
_analyst

This is the role intended for Security Analysts that need to
perform work or overseer all VMDR Task and VMDR Task Group
records, regardless of which Assignment Group they are
associated to.

## VMDR Task
- Grants Read/Write/Create access to all VMDR Tasks and
Related Functions

## VMDR Task Group
- Grants Raad/Write/Create access to all VMDR Task Group and
Related Functions
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Get Started

Follow the steps to install Qualys Core and Qualys VMDR applications.

Install the App

Visit the ServiceNow Online Store and search for Qualys apps.

Qualys Core

Connect and Configure access to Qualys
VMDR for ITSM

©

Qualys Inc Wi
Qualys CMDB Sync Service Graph
Connector
Sync your IT Assets Inventory between
Qualys and ServiceNow.

Qualys Inc B i b dh el g

©

Qualys Inc

©

Qualys Inc

Qualys VMDR

Eliminate silos between IT and Security
teams, and automate vulnerability...

whwww

Qualys CMDB Sync

Sync your IT Assets Inventory between
Qualys and ServiceNow.

b3t
o
g
b3
hieg

- Go to Qualys Core app, and click Request App.

servicenow. | Store Q_ Qualys VMDR

Apps and Solutions  ServiceNow Products  Integrations  Innovation Lab  Eventt

Back to Search Results

Qualys Core

Connect and Configure access to Qualys VMDR

Gualys Inc
Compatibility: Tokyo, San Diego, Rome | Other App Versions

Pricing
Free

& Contact Seller —

@ View Profile

Type
Integration

sroewin W f

Version

Your Qualys representative will enable the application for you if you have Qualys VMDR
subscription. The app then appears in the “Downloads” list of your instance. Click “Install”

to start install the app.

- Go to Qualys VMDR app and perform the same steps that you followed to install the

Qualys Core application.

servicenow. | Store O, Qualys VMDR

erviceNow Products  Integrations  Innovation La

¢ Back to Search Results

©

Qualys VMDR

Eliminate silos between IT and Security teams, and automate vuinerability management

Qualys Inc.
Compatibility: Tokyo, San Diego, Rome | Other App Versions

Pricing
Free

WYY ¥ NoReviews

Search

Cartina 4pp Request App

0 Contact Seller —

© View Profile

Type
Integratio

sharewith W ——

200

Other App Versions
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https://store.servicenow.com/sn_appstore_store.do#!/store/application/dd3cef9c87a2f0107bb3a86e0ebb3529/1.0.6?referer=%2Fstore%2Fsearch%3Flistingtype%3Dallintegrations%25253Bancillary_app%25253Bcertified_apps%25253Bcontent%25253Bindustry_solution%25253Boem%25253Butility%25253Btemplate%26q%3Dqualys&sl=sh
https://store.servicenow.com//$appstore.do#!/store/application/dd3cef9c87a2f0107bb3a86e0ebb3529/1.3.0?referer=%2Fstore%2Fsearch%3Flistingtype%3Dallintegrations%25253Bancillary_app%25253Bcertified_apps%25253Bcontent%25253Bindustry_solution%25253Boem%25253Butility%25253Btemplate%26q%3DQualys%2520VMDR&sl=sh
https://store.servicenow.com/sn_appstore_store.do#!/store/application/3bd20edd1b56fc10203dca22604bcb7c/2.0.0?referer=%2Fstore%2Fsearch%3Flistingtype%3Dallintegrations%25253Bancillary_app%25253Bcertified_apps%25253Bcontent%25253Bindustry_solution%25253Boem%25253Butility%25253Btemplate%26q%3Dqualys%2520core&sl=sh
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In the Search field, type Qualys, and then select Qualys Core and Qualys VMDR from the

left pane.

After you are done, the new modules appear in the ServiceNow instance as displayed in
the following image:

ServiCenow. service Management

Qualys Core

=
Qualys Core

W Configuration
Connectors
Detection Event Rules
Assignment Rules
SLADeinitions

W Data import
Import Configurations
Transform Maps

‘Scheduled Imports

[l + semadmmsiaton

(C)

- Create and Deploy
eate, modify and dep!

cr

Guided Setup
Guided Setup toolsto el

System Administration

Data Management
WEE | thevay data i stored and displayed

Fomm  Homepages
Conure Romepogesfor S Desk and Self S usrs

@ soeree -

Q0L
& o

DV Qe S ——

UserInterface

74 "

Note: The options in the Qualys Core and Qualys VMDR applications that you can
view are different based on the user group to which you belong. For information on
user roles, see User Roles and Permissions.

Upgrade the App

To view if you have a new version of the application available and upgrade the new version
of the application:

In ServiceNow application, navigate to System Applications > All Available Applications >

All

Search for the application you want to update. You can see the version of the application

that is installed currently.

©

by Qualys Inc

©

by Qualys Inc

Qualys Core

* Version12.8
* Installed on Jun 21,2022

« Uploaded by mbachhav viaven01263 on Aug 26, 2022

Qualys VMDR

* VersionL11
* Installed on Jun 21, 2022

+ Uploaded by mbachhav via ven01263 on Aug 9, 2022

10

1.2.8 [Installed]

1.1.1 [Installed]

. 4
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If there is a new version available, it is displayed in the drop-down list. Select the version
you want to upgrade to and click Update.

bd Qualys Core

@ * Version13.103

* Created on Feb 14,2023 13.103 ¥: Update
* Uploaded by nate.anderson via ven04911 on Feb 14, 2023

Show More

by Qualys Inc

. Qualys VMDR

@ * Version20.1

+ Created on Feb 03,2023 201 v Update
*  Uploaded by nate.anderson via ven04911 on Feb 2, 2022

Show More

by Qualys Inc

11
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Qualys Core

Qualys Core application manages connection between ServiceNow and Qualys
Vulnerability Management, Detection and Response (VMDR), data import, import
schedules, vulnerability detection rules, and service-level agreement (SLA) definition.

In Summary

Configure Basic Authentication Credential - Create basic authentication credential record
in ServiceNow to authenticate the connection.

Configure Connection to Qualys Applications- Configure the connection with Qualys and
use Test Connection to know if the connection between ServiceNow and the Qualys is
working fine.

Configure Data Import - Provide details of import configuration and schedule imports.

Configure Detection Event Rule - Provide details to define which vulnerabilities should be
added to ServiceNow for creating tasks.

- You can define one-to-one rules for creating the vulnerability tasks from the detections
and you can also define grouping rules to group the vulnerability tasks based on different
criteria. You can define the detection event rule to create change requests which can be
used to apply patches to the host assets for remediation.

Configure Assignment Rules - Provide details to create rules for assignment of tasks to
appropriate groups.

Configure Patch Deployment Settings - Define default settings for the patch deployment
jobs.

Configure Basic Authentication Credential

You need to set up a basic authentication credentials record in ServiceNow for
authenticating a connection to Qualys system. You must have a Service account with
Manager privilege and API access in Qualys subscription to setup basic authentication
credentials.

Edit User LaunchHelp [ %

Information: Users must be employees or contractors of your company who are bound biigat protective as inthe Qualys®
© senvice agreement

General Information
User Role

Locale
User Role: * Manager v

User Role

Options Business Unit: * Unassigned =

Account Activity -

SoAL User configurations to transfer:
Changing the user's business unit or user role will resilt in the removal of personal
configurations and asset groups from the user. Select the options below if you wish to transfer
those configurations and asset groups to the user's Manager/Unit Manager. Leam more

() Transfer personal configurations
Includes option profiles, report templates, scheduled tasks, distribution groups, search lists, web
applications and compliance policies

O Transfer Asset Groups
If not selected, configurations may become inactive (e.g. report templates, schedules) and you'll
need to manually update them

13
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Note: Contact your Qualys administrator for your account to get service account
details.

To configure basic authentication credential:
In the application navigator, go to Connection & Credentials > Credentials, and click New.
Click Basic Auth Credentials from the list.

JE # 5w sim

Username Johndoe123

A connecti nnection and untime. More than one Credential can be active per Connection Alias at a time. If more than one credential is active, they will be used in order.

submit

Enter required details to create an authentication record:

Name - Provide a name for the authentication record.

User name - User name to be associated with the authentication record.
Password - Password for the user name.

Click Submit. This record is available while selecting credentials for authenticating
connection to Qualys.

Configure Connection to Qualys Applications
Once you install the Qualys Core app, you need to configure a connection with Qualys.

Note: Qualys Core supports domain separation that separates data between service
providers, partners, and sub-organizations. Support for domain separation allows
Managed Service Providers (MSPs), Managed Security Services Providers (MSSPs) and
Qualys Partners to customize business process definitions and user interfaces for
each domain - a form of delegated administration.

14
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To add a new connector, go to Qualys Core > Configuration > Connectors, and click New.

< = Qualys for ServiceNow Connector f

= Newrecord = oo submit

Qualys for ServiceNow Connector .

Connection

Iy
+ Name: Human readable name to describe the connector
« Active: Deactivate this connector

ifthe last connection test was connector

Adive |V VMDR Healthy
Name NewConnector FIM Healthy
PM Healthy

Connection

Connection i i il i o lys for ServiceNow server
+ Endpoint: Primary URL for the server this connector will be speaking with
+ MID Server: Specify the MID Server that web service calls will go through to reach the endpoint

s Endpoint | hitps://qualysapi.qualys.com/ a MID Server Q

Enter required details to create the connector:
Name - Provide a name for the connector.
Active - Select this option to activate the connector that you create.

Endpoint - Enter primary URL for the Qualys server that this connector will connect to get
data from Qualys. To identify the endpoint URL, refer to the API URLs in
https://www.qualys.com/platform-identification/.

MID Server - The MID server can work as a proxy server/middleman between ServiceNow
and Qualys pod, wherein the ServiceNow instance work with limited reachability to
outside sources.This is an optional field.

VMDR Healthy, FIM Healthy, PM Healthy check boxes indicate whether the last test
connection with respective applications was successful for this connector.

Note: These check boxes are not available while configuring a new connector. Once
create a connector and click Test the connector, the check boxes are selected based
on the successful connection.

Authentication

Authentication

The following section identifies fields required to authenticate against the Qualys for ServiceNow service
« Credential: Select the appropriate credential for authentication

% Credential Qualys_ITSM_Demo Q@

Credentials - Select appropriate credentials that you have created for authentication. For
details on how to create basic auth credentials, see Configure Basic Authentication
Credential.

Settings

15
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Enter the required details for rescanning a host.

Settings v
Settings related to behavior of Detections, Tasks and Hosts that are associated to this connector.

Detection Re-Scan

When nitiating a rescan of a host, use the following default scanner

Default Scanner Appliance AZURE-Demo-EastUS2-Scanner alle WebPortal URL  https://qualysguard.qg2.apps.qualys.com &

Default Option Profile Copy of All Authentication - 65K Qe

Default Scanner Appliance - Select default scanner to be used for rescanning from the
Qualys Scanner Appliances list.

Default Option Profiles - Select default option profile to be used while rescanning from the
Qualys Option Profiles list.

Note: The list scanner appliance and option profile will be available only when the
import configurations are run and cannot be selected while creating a new
connector. Contact your Qualys representative for setting up default scanner
appliance and option profile.

Web Portal URL - Enter Qualys platform URL. Using this URL, you can view the patch
deployment job directly in Qualys Patch Management application. See Reports and
Dashboards.

To identify the endpoint URL, refer to the API URLs in https://www.qualys.com/platform-
identification/

Click Submit to create the connector.

Then, after configuring and saving the connector, click the connector you have created
from the Connectors list, and click Test the Connector from the Related Links.

— Qualys for ServiceNow Connector -
| = Qualys qg3 (vmdra3sa) @ = coo Update Delete AN

(® SUCCCESS: Connection appears to be authorized and validated for VMDR,FIM,PM modulefs). >4

Qualys for ServiceNow Connector
Connection information that allows talk to
« Name: Human readable name to describe the connector
« Active: Deactivate this connector
« Healthy: Indicates if the last connection test was successful for this connector

Active v VMDRHealthy |+

Name Qualys qg3 FIM Healthy

PMHealthy

Connection

[ f that allows talk to
« Endpoint: Primary URL for the server this connector will be speaking with
« MID Server: Specify the MID Server that web service calls will go through to reach the endpoint

% Endpoint  https://qualysapi.qg3.apps.qualys.com & MID Server Q

If the connection is healthy, proceed to import data. Else, use the error message and the
system logs to resolve the error.

16
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Associate Import Configuration to Connector

You must associate the import configuration to a connector so that you can execute the
import.

To associate import configuration to a connector:

Go to Configuration > Connectors, and select the connector for which you wish to
configure imports.

Navigate to Import Configurations, and click Edit.

From the Collection list, select the import configuration and move to the Import
Configuration List.

- If you want to configure Qualys Core to work with Qualys VMDR, select the import
configurations, as shown in the following image:

Add Filter | Runfilter (%)

--choose field -- v | --oper- v --value --
Collection Import Configurations List
O\ Qualys ITSM Demo
Default: FIM Incident Event Import - All Default: Host Asset Import - All
Default: FIM Incident Import - All Default: Host Detection Import - All

Default: Knowledge Base Import - All
Default: Option Profiles - All
Default: Scanner Appliance - All

Cancel m

Name Default: Host Asset Import - All

17
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- If you want to configure Qualys Core to work with FIM application, select the following
import configurations, as shown in the following image:

Default: Host Detection Import - All
Default: Knowledge Base Import - All
Default: Option Profiles - All

Default: Scanner Appliance - All

Import Configurations List

Qualys ITSM Demo

--value

Add Filter | Runfilter (%)
-- choose field -- v  --oper- v
Collection
o\
Default: Host Asset Import - All -~

Default: FIM Incident Event Import - All -~

Default: FIM Incident Import - All

Cancel m

Name Default: FIM Incident Event Import - All

Click Save.
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Configure Data Import

After configuring a connection to Qualys, you can view data imported from Qualys for
VMDR and FIM - KnowledgeBase, option profiles, scanner appliance, host assets for VMDR
and FIM incidents and incident events for FIM.

Qualys Core imports data from Qualys by using the import configurations, where you need
to associate a defined import configuration to a connector to execute importing data from
Qualys.

Import Configurations
Go to Data Import > Import Configurations to review the data import configured by default.

= \mpmcnnﬁgumtmnsm Search Name v | [search 1 toTof7
<

(=B F om

& Q =Name a = Active

Search Search

@ Default: FIM Incident Event Import - All ® true
(i) Default: FIM Incident Import - All ® true

(D Default: Host Asset import - All ® true

(i) Default: Host Detection Import - All ® true

() Default: Knowledge Base Import- All ® true

(i) Default: Option Profiles - All ® tue

(i)  Default: Scanner Appliance - All e

If you want to configure Qualys Core to work with Qualys VMDR, the following import
configurations are available by default. - Host Asset Import

- Host Detection Import

Note: Configure the host detection event rules before you import host detections.
For host detection rules, see Configure Detection Event Rule.

- KnowledgeBase Import
- Option Profiles
- Scanner Appliance

Review the import configurations to check what data is being imported. For example,
Import Configuration: Host Detection, review the Detection Filters, Vulnerability Filters,
Host Filters tabs, modify the values as required, click Update to update configuration.
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— Import Configuration: Host Detection -
< | = DefaultzHost Detection import - All @ T o Uplate| Delele | N
Name Default: Host Detection Import - All
Adtve v

Detection Filters |~ Host Filters | Vulnerability Filters | Additional Information

Severities 45

Update || Delete

If you want to configure Qualys Core to work with FIM application, review and ensure that
the following import configurations are active:

- FIM Incident Event Import
- FIM Incident Import

If you are not using FIM application, you can deactivate the FIM-related import
configurations.

Schedule Import

You can define schedules to import each type of data at a specified frequency to automate
data import. You have default import schedule associated with every import
configuration. Go to Data Import > Scheduled Imports to view the schedules defined by
default.

The following image displays the default schedules for each import configuration defined
for FIM and VMDR.

= DataTransferDEﬁmtlnnsu Search | Name v | Search 1 to7of7

[ Y Au-Type containsimport

& O =nemea = Active = Connector = Source Table = Update Frequency (minutes) = Latest Change Synced = updated

Search fearch Search Search Search Search Search

@ WM ® true (empty) 20 (empty) 2022-09-0622:32:36
(D Default:FIM Incident Import -Nightly @ true (empty) 30 (empty) 2022-09-0820:00:21
(D Default: Host Asset Import - Nightly ® true (empty) 30 (empty) 2022-09-1020:00:50
() Default: Host Detection Import- Nightly ~ ® true (empty) 20 (empty) 2022-06-2102:06:08
@ {8 A G029 52 DT o true (empty) 30 (empty) 2022-09-1000:38:55
Nightly

(D Default: Option Profiles - Every4hours @ true (empty) 30 (empty) 2022-08-09.00:00:30
(i) Default: Scanner Appliance - Nightly ® true (empty) 20 (empty) 2022-08-0901:00:20
Actions on selected rows v 1 to7of7

Note: We recommend to import each type of data at least once everyday. However,
you can define to import data multiple times a day depending on your infrastructure
and scanning frequency.

In the default import schedules, review the following sections:
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If you want to copy the default import schedule, modify, and create a new schedule, open
the default import schedule, click make changes to the same, right-click the toolbar, and
click Insert and Stay.

— Data TransferDefinition =
< = Default:Host Asset Import - Nightly @ = coo Update  BecuteNow | Delete N |,

Name | Default: Host Asset Import - Nightly

% Import Configuration | Default: Host Asset Import - All alle s Q

& Create a copy of the current record with any modified values, and redirect to the new record
View > ST

* Type Import- With Configuration v

. P 150 8601 format: " h: . Ex: 2017-01-01700:00:00,0007 Comatn Faodte
« FIM Incdent Event: Delta Timestamp i not needed CopyURL
+ Others: Delta in150 8601 forma: " . Default Ex: 1999-01 01000000

History P
Reload form

DeltaTimestamp | 2023-03.03T06:10:007 * Chunk size 2500
Chunk Data Load Timeout (sec) 300

Import Threads | | HostImport Thread #1 import only when all

Stop Processingon Chunk Ertor |/
Schedule | Seripts
e Daily v Conditional

Time(run_time) | Hours 22 00 00 Runastz System (America/Los._Angeles| v
Update | | ExecuteNow | Delete

= namens!euuhsn Search | Percent Complete v | Search 1 o2t b Bh

7 Data Tranfer Definition = Default: Host Asset mport-Nightly

& O =Number =sae = connector = Job Started = Total Records = percent Complete & = Job Stopped = Duraion (seconds) = Updated

Review the following fields:

Delta Timestamp - Indicates the date and time when this scheduled import was last run.

Note: If the Delta Timestamp field is populated, the data import is executed as
delta. For the first import execution, clear the value in the Delta Timestamp field to
perform full import.

Chunk Size - Indicates the number of records to be imported in a chunk.

Chunk Data Load Timeout (sec) - Provide the time limit in seconds between the time when
the chunk import record is created and the time when loading of data is completed. If it
exceeds the defined time, the chunk is marked with an error.

For the chunk size and chunk data load timeout fields, the default values for each type of
import schedules are as below

Type of import schedule Default Chunk Size value Default Chunk Data Load
Timeout value

host asset 2500 300

host detection 50 300

KnowledgeBase 1000 300

By default the Qualys VMDR subscription includes the Standard API service level. For the
default Qualys API rate limits, refer to https://www.qualys.com/docs/qualys-api-
limits.pdf.

Stop processing on Chunk Error - Select this check box if you want the scheduled import
operation to stop when a chunk is marked as an error.

Schedule
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Run - Select the frequency of import from the list. The related fields change based on the
value you select in the Run field.

Run as tz - Select the time zone to be followed for this import schedule.
Run as - Select the user or user group.

Conditional - Select this check box to add more conditions on the import schedule.

Schedule | Scripts

Run Daily v Conditional | v/
Time(run_time) Hours |00 [ 00 Runastz System (America/Los_Angeles) ~
Run as John Doe Qe

3« 355 QA v & | F @ B % | B

1Ll
.

condition @ @ | |0 E
1

Script - You can enter a script to customize the import schedule.

Note: There is a default import schedule associated with every import configuration.
We recommend you to retain the default values for all the fields except, Delta
Timestamp and Schedule fields.

View Jobs

After scheduled import execution, data transfer jobs are processed. You can view details
of data transfer jobs - job number, status, start and stop time, completion percentage,
associated connector, and so on.

= Data Transfer Jobs m Search | Number v | Search WM 1 to6of6
=) ? All> Created on Today .or. State not in (Complete, Complete with Errors, Cancelled) > Data Transfer Definition Type in (Import - With Configuration, Import - Generic
=3 = Number & = Data Transfer Definition =sute = JobStarted = Total Records = Percent Complete = Job Stopped = Duration (seconds) = Updated

()  DATAJOBOISS6L  Default: FM Incident Event import - Eve.. InProgress  2022-09-0805:07:55 oo N (=t 2022-09-11 11:01:30
()  DATAIOBOI40816  Default: Option Profles-Every 4 hours Complete  2022-09-1100:00:05 45 1000 [ 2072-09-1100:00:35 30 2022-09-1100:00:35
()  DATAIOEOI40820  Default: Knowledge Base Import - Nightly Complete  2022-09-1100:00:05 0 100 N 2022-09-1100:15:20 915 2022-09-1100:15:20
()  DATAJOBOI40898  Default: Scanner Appliance - Nightly Complete  2022-09-1101:00:05 &7 100 N 2022-09-1101:0020 15 2022-09-1101:00:20
(i)  DATAJOB0I41125  Default: Option Profiles- Every 4 hours Complete 2022-09-11 04:00:00 a5 000 [N 2022-09-1104:00:20 20 2022-09-1104:00:20
(i)  DATAJOB0I41431  Default: Option Profiles- Every 4 hours Complete 2022-09-11.08:00:05 a5 1000 NN 202209-1108:00:25 20 2022-09-1108:0025
Actions on selected rows M 1 to6ofé

The data transfer jobs track the higher-level batch of data that is being transferred. When
the data transfer jobs are processed, data chunks are created. Those chunks are
associated to the job.
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You can view details of the data chunks in each data transfer job, such as, chunk number,
the associated data transfer job, status, start and stop time, and so on.

= DavaTvanslerChunksu Search | Number

v | Search

[ § All>Createdon Today>Data Transfer Job Data Transfer Definition Typein (Import - With Configuration, Import - Generic)

& o} = Number 4
Search

(i)  DCHNK0000005282

()  DCHNKO000005283

(D  DCHNKO000005284

(D  DCHNK0000005285

(D) DCHNKO000005286

(D  DCHNK0000005287

(D  DCHNK0000005288

= Data Transfer Job

Search

DATAJOB0140820

DATAJOBO140816

DATAJOBO140816

DATAJOBO135561

DATAJOBO135561

DATAJOBO135561

DATAJOB0140898

= Chunk Number

Search

=state

Search

Complete

Complete

Complete

29

Complete

29

Complete

300 Complete

Complete

= ChunkStarted

Search

2022-09-11 00:00:05

2022-09-11 00:00:05

2022-09-1100:00:30

2022-09-11 00:09:54

2022-09-1100:28:9

2022-09-11 00:46:14

2022-09-11 01:00:05

= Chunk Stopped

Search

2022-09-11 00:15:15

2022-09-11 00:00:25

2022-09-11 00:00:30

2022-09-11 00:28:34

2022-09-11 00:46:10

2022.09-1101:03:13

2022-09-11 01:00:11

= Duration (sec)

Search

1120

1051

1019

S

= Total Records

Search

&

tw200fds B PP

= Updated

Search

2022-09-1100:15:16

2022-09-1100:00:25

2022-09-1100:00:30

2022-09-1100:28:34

2022-09-11 00:46:10

2022-09-1101:03:13

2022-09-1101:00:11

You can monitor progress of data transfer chunks based on the State - Errors, In Progress
(Making API Call), Importing (Import Set and Transformation), Completed (All done, move
onto next check).

Import Row Tables

The import tables present the data imported from Qualys through scheduled import
operations from VMDR and FIM.

= *

W import Row Tables
Qualys--import Row Hosts
Qualys - Import Row: Knowledg
Qualys -import Row Host Dete....
Qualys - Import Row: Scanner ...
Qualys -mport Row: Option ...
[
Qualys - Import Row: FIM Incide.

'V Data Tables

= | Qualys-Import Row: Hosts

3 9 A
7 Al
Q  Screated
Search
N 2me
W e
2001
®
© Fww
212001
D 0020
@ mex
O nex

Search | Created

=sute

search

Updated

Updated

Updated

Updated

= Targetrecord

search

Qualys - Host Asset:
Qualys - Host Asset:
Qualys - Host Asset: demo-

[

‘Qualys - Host Asset: demo.

= Targettable = Transform Map

search search
Qualys - Host Asset

lys: Host Import
pxquals_core_qualys_asset] 3UsHostimport

Qualys - Host Asset

[x_quals_core_qualys_asset] Qualys: Host import

Qualys-Host Asset

x_quals_core_qualys_asset; 2ualvs:Hostimport

Qualys- Host Asset

[ quals_core_qualys_asse] ahs-Hostimpott

I ASSET_GROUP_IDS

Search

1188033

118802

1188932

1192240

= ASSETID

search

= Asset Crticality Score

search

1 to200f13812

> >

= AssetRis|

Search

The import row tables for hosts, host detection, scanner appliance, option profiles, and

knowledgebase present data imported from Qualys VMDR application.

The import row tables for FIM incidents and FIM incidents events present data imported
from Qualys FIM application.

The tables are automatically updated after the scheduled import runs for each type of

data. Click the information icon or value in the first column to view the details.
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Data Tables

The data imported is transformed based on the field mapping and is presented in the data
tables.

= | Qualys- HostAssets m Search  Name v | search 1 20033700 b Bh
= * By
& O Shamea = hssetid =Configurationitem == PossibleCiMatches = Qualysid =rw =rw = LastVuinerabity ScanDate = Netbios = Networkld
I Search Search Search Search Search Search Search Search Search
1Y, Deta Jeblee ® a7 (empty) 2022.02.0306:3828 7056
ualys Knowiedge Base

o o ® soogEmE" (empty) s 20220508 112717 0
Host Assets i

® a1 (empty) 3 20220205 080859 7056
Host Detections

® 481 (empty) ] 2022-02-26 04:58:37 714056
Asset Groups

sossa7827 (empty) 5 2020617023456 0
Qualys Tags

©) aoEe 3 20220314 21:1833 74056
Scanner Appliances
s ® o e (empty) s 20220524 21:46:47 0
(o ® 54 o 2022.06.1520:4108 0
FM incidents ® fempty) 2020220154530 74056
FIM Incdent Events ® P fempty) J— 202202.0922:49:03 7056
(s altial ® . (empty) 2022.05-1802:50:01 0
FIM Incident Event Queue )

O} e R, (empty) 2 2021.081208:05:13 0

You can view data tables for hosts, host detections, scanner appliances, option profiles,
and knowledgebase as well as for Qualys tags, asset groups (created from host assets
import), and scan executions (generated based on scans launched) for VMDR data.

You can view data tables for FIM incidents, FIM incident events, FIM event profiles, and
FIM incident event queue for FIM data.
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Configure Detection Event Rule

You can define the rules for detection of events for which the tickets will be created based
on type and severity of vulnerabilities, asset tags, RTI’s, and Qualys Risk Score. You can
also create detection event rules for creating change request in the ServiceNow Change
Request.

Note: This section is applicable only if you want to work with Qualys VMDR
application.

There are two types of detection event rules that you can create.

- One-to-One Rules: The one-to-one Rules create a separate vulnerability task for each
detection. You must set the one-to-one detection event rules for creation of grouping
rules.

- Grouping Rules: The Grouping Rules use the vulnerability tasks created by the one-to-
one rules and group the tasks based on different criteria.
One-to-One Rules

Go to Configuration > Detection Event Rules to view the detection rule that is available by
default. However, you can update an existing rule or create a new rule.

= Triggerwhen = Description = Destination table v =order = Stop processing
Search Search search Search Search
Type = Confirmed and. QID Severtylevel n 4- High, - ritca).and. ST0and. —
QD Threat nteligence conain Cisa_ Known_Exploftd_Vulns and. Qualys Host Qualys ASsel Tags  —rce g wonr T st 1000 true
higher) CONTAINS Critical Assets , e uat iy task)
Qualys Host Qualys Asset Tags 5 and. Qualys dete or
. !
®  * Ticket Creation Polcy false QI Threat d TpesConlimed; oo Coetfor  Qubs DR Tk 203 false
G Securitytocrea, _qual$_vmdr_vuln_task_item]
Vulnerabily
COPY- Create Vulnerabilty Type=Confirmed and. QD Severtyleve i 4 Hig, il and. Qualys deectonscore>g0.and. (- —
(©  TasksforConfirmed Detections ~ false QID Threat Intelligence contains Cisa_Known_Exploited_Vulns .and. Qualys Host Qualys Asset Tags fetmaleneitiy  Ouolys, ad 1000 true
Task forevery de. 1 quals_vmdr_vuin_task_item]
Sev4 orhigher) CONTAINS PCl Scope
_ * Copt-Cremewnenbity Type=Confimed and. QD Severty level i 8- Hig, - il and.QUIYSetecton sore> 0,00 ¢,
(©  TasksforConfimed Detections false QID Thieat nelgence contins Cisa_Known_ Bxploted_Vulns and. Qualys Host QUaySASSEUTAES  ep e wonr o S D 1000 tre
(sevt orhigher) CONTAINS PCi Scope Ty SO NCECE]
o Certicate Rule with ssL Certiicate Rulewith SSL~ Qualys -VMDR Task
Certificate Bl oS54 1D QD 42,3817 70,3817 4
@ S tue QIDQID in 38116, 38142, 38167, 38168, 38169, 38170, 38171, 38172, 38173, 38174, .1 Rt ot s Y false
Qualys Host Qualys Asset Tags Facing Assets and. Qual >85.and
® o intemetracingassets true Qualys Host TuRisk CricalyScore 4. and. Qualys Host TruRis Sore > 850.and. Q1D Severtylevel = 110 oo o>e5 - Quabys WORTask |~ false
5-Critical.and. Type = Confirmed..and. Qualys Host Qualys Asset Tags CONTAINS e Pk Bt e Bl
~ * Bample CreateProblem ) Thisis an example rule
@ o= false QID Severity level =5 - Critcal bt Problem [problem) 100 fale
© o Estnginadent true Qualys Host Configuraton tem i ot empty Incdent [incident] false
. and. Qualys dows and
® * achableTasks false st Change Request [change_request 102 false
Actor v 1] ofs

Note: We have created a separate destination table: Qualys - VMDR Task for the
Qualys VMDR vulnerabilities. However, you can change the destination table to
create a incident task or request task.

You can use the Copy this Rule option to clone the detection rule, modify the required
field, and save the rule with a new name. See Clone a detection rule.
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¢ I= Detection Event Rule
== Newrecord

A=Y submit
=

Detection Event Rules

The detection event rules allow specifying what records to create a record Is inserted or updated on the source table specified.
+ Name: A name to reference this rule by
* Active: Is this rule active or not?

 Source table: The source table to watch for record changes and run this rule of the Trigger Criteria are met
* Table: The table to create d thisrule s triggered.

* Description: A long description to provide more detail about the purpose of this rule.

+ Destination Form View: When enabled, will allow specifying the form view of the destination record. This Is to help for scenarios when you need to show different information based on the groupings performed.

Name Certificate Rule with SSL Certificates QIDs
Active |V Logging level Errors
Source table Import Configuration: Host Detection [x_... ¥ Enable grouping
Destination table Qualys - VMDR Task [x_gual5_vmdr_vuln... v
Source field to set to Destination - None - v
Record
Description

Review the existing values in the fields and modify as required:

Source table - Select the source table from where the detections are retrieved, that is, host

detection table.

Destination table - Select Qualys - VMDR Task from the list of tables. This table is created

for Qualys VMDR vulnerabilities.

< || = Detectoneventiie @ = oo Update  Delete N2
Name C Tasks for ‘higher)
. 2 P .
ISR Qualys - VMDR Task
e
[x_quals_itam_app_qualys_asset_details]
Qualys Asset Groups
Trigger Criteria x_quals._itam_app_qualys_asset_groups]
Belowyou can speciy the criteria Inwhich this | o31ys asset Tags  fecord inth Source table as they are processed.
For change request creation, select Change Request in the Destination table.
g -
<] = pine P 5 e wpime o A
Detection Event Rules
« Name: A name to reference this rule by
e
e e
* Destination Table: The table to create a record in when this rule is triggered.
Source table Qualys - Host Detection [x_quals_core_host_det... v Enable grouping.
‘Source field to set to Destination Record —None — .

26



Qualys VMDR for ServiceNow
Qualys Core

Description - Enter description for detection event rule.

The Trigger Criteria tab defines when this detection event rule runs.

Trigger Criterla | Assignment

Trigger Criteria
Below you can specify the criteria In which this rule should execute. This is based on data on each invidual record in th Source table as they are processed.

* Order: The order in which this rule should run, inrelation to the other rules for the same Source table
« Stop Processing: When this rulels triggered, should we stop processing rules that are ordered after this one?
« Triggerwhen: This rule will be triggered the source record being Inserted or Updated matches the condition criteria spcelfied.

Order Stop processing

Triggerwhen 6231 ecords match condition

Add Filter Condition | Add "OR" Clause

All of these conditions must be met

QD.QID ¥ | Isoneof v 38116 AND | OR | X
18142 i
28167 “

— choose field — v | —oper— —value X

Order - Provide the number that indicates the order of priority for running this detection
event rule. The value in the Order field is a relative value and the detection event rules are
executed in ascending order, that is, lowest to highest. The order assigned to a rule helps
decide the priority when multiple rules exist for the same table.

Stop processing - Select this check box to stop processing the rules ordered after this rule
once the detection conditions are met.

Trigger when- Define criteria on the host detection record that should trigger this
detection event rule and create a record in the destination table. You can use single or
multiple attributes and filters.

You may need to use the Show Related Fields option at the bottom of the field list to allow
you to get to reference data such as QID => Severity to validate the severity level of a
detection record.

Trigger Criteria ~ Assignment

Trigger Criteria
Below you can specify the criteria In which this rule should execute. Thisis based on data on each invidual record in th Source table as they are processed.

» Order; The order in which this rule should run, in relation to the other rules for the same Source table

* Stop Processing: When this rule is triggered, should we stop processing rules that are ordered after this one?

* Trigger when: This rule will be trigag” ———————————————_ted matches the condition criteria spceified.
( \

&

Tags to exclude list A

Tagstoinclude

Order Stop processing

Tags to Include list
Trigger when Update name
Updated

Updated by

Updates

Show Related Fields
—choose field - v | -oper— ~value~ X

is v | Confirmed AND | OR | X
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For change request creation, the Trigger Criteria can be set as displayed in the following
image:

Trigger Criteria

order 0 Stop processing

Qopatchable v e v e ~ mo | or || x
QualysHostOpenatingSystem v | contans || windous mo ok || X
Qualysdetectionscore v | gesterthanors v || 90 mo ok || x

The Assignment tab defines how the vulnerability tasks are assigned once this detection
event rule is triggered.

TriggerCriteria | Assignment

Assignment

th group be set on the d record? Note: This only applies If ion table has Group field.
- Assignment group based on: Select how on ion record. This will only set the Assignment Group If it is empty on the destination record.

° Rules: Leverage built-in routing functionality.

© Detection Event Rule: Specify th group tobe i hi rule.

© Group by fielct Il using grouping, and one of the Group by fields references the *Group® able, we will use the most specific grouping reference Lo (he Group table [sys_user_group].

© Source Configuration item Field: If the source record being processed has a reference to Configuration Item, select a fleld from that table/record o set the assignment group to.
roup: What beused.

o Based on Detection Fvent Rufe-When assignment is hased on Defection Fuent Rule ifselt, spacity the assignment group to use.

o Based on Group by field: When assignment s based on Group by Field, this will be the Default Assignment Group if the group by field does not have one spacified

Assignment group based on [ ServiceNow Assignment Rules ~ ‘
ServiceNow Assignment Rules

Detection tvent Rule
Group by field

Source Configuration item Field
Related Links

Copy this Rule

- If the Assignment group based on ServiceNow Assignment Rules is selected, the tasks
are assigned based on the rules set in the Reprocess the detection event rules.

- If the Assignment based on Detection Event Rule is selected, you can select a value in the
Assignment Group field. This assignment group will be applicable only for this rule.

- If the Assignment based on Group by field is selected, you can select a value in the
Assignment Group field. This assignment group will be applicable only for this rule.

Click Submit to create the detection event rule.

Detection Event Field Maps

Once the detection event rule is created, add field mappings. Click the detection event rule
that you created, and go to Detection event field maps.
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You must add the following three fields mappings.

Detection event field maps (7) | Assignment rules (16)

= | Detectionevent fieldmaps n Search | for text v | Search 1 to7of7 o
(] ? Detection event rule = Create Vulnerability Tasks for Confirmed Detections (Sev 3 or higher)
& O =sourcefield = Destination field = Coalesce

® i host_detection false

©® mdbd cmdb_ci false

@  [Iscripti priority false =

@ Isciptl short_description false

@  [lscriptl source false

@ ssid correlation_id true

@  [Iscript] state false

Actions on selected rows... ~ 1 | toTof7

You can add any additional field mappings as per your requirement.

Note: We recommend to set the Coalesce field as mentioned in the example to avoid
creation of duplicate entries.

Grouping Rules

With grouping rules, you can group individual vulnerability tasks in a group based on
different criteria. This results in reducing the number tasks making the remediation easier
remediation.

To define the grouping rules, you must have one-to-one detection rules configured in
Qualys Core. The grouping rules use the tasks from the Qualys - VMDR Task table and
group them based on the rules that are defined.

Go to Configuration > Detection Event Rules > Grouping Rules to view the grouping rules
that are available by default. However, you can update an existing rule or create a new
rule.

B - search 1 wsofs

(2§ Al>Enablegrouping=true
@ QO =hame = active = Triggerwhen = Descrption = Destination table v = order = Stop processing
Search Search Search Search Search Search Search
! and Host Trufisk
. COPY-Group Rule Based 0n QDS Group Tickets by QDS Qualys - VMDR Task Grou
® o TNR:HW C false Score> 700 and. State = Open and. Qualys Detection Connector- % ygo & jals e mz o false
‘Severity TruRisk=700 rity for QDS x_quals_vmdr_vuln_t
and. Host asset Operating System contains Windows .and. QID Patchable = true a >
< and High,5 -
© [ melsueubivisy i, S o e Qs DR Tk Grup R
Configuration tem Confirmed Vulnerabilty.and. Host aset Qualys Asset Tags CONTAINS Windows Assets et e N =i gToup!
® Asset Tggdwith Productionand. = CRITICAL and. Qualys Detec Group Ticketsby QDS Qualys - VMDR Task Group »
® Tasks with Critical QDS Severity oS Tags CONTAINS Production Severity [x_quals_vmdr_vuln_task_group] alse
. Qualys Detection Qualys detection sore > 80.and. Host asset Truisk Score > 700 .and. tate  Group Rulesbasedon  Qualys-VMDR Task Group
5
Group Rules Based on G
@ © CroupRulesasedon QDS Severtty  true ~open QDS Severty i quals_ymdr_vuln_task_groupl ADihEe
~ ® GroupRule Basedon QDS - ! and. RISk Group Ticketsby QDS Qualys - VMDR Task Group i
© Severty TuRisle00 el Score> 700 and. State = Open Severity for QDS>80... [ quals_vmdr_ln_task_group] =
c and High,5 -
@ O mlkumu T g, b 4 o Asdiags Qe DR Tk rup —
Sl S CONTAINS Windows Assets DlguaS mdmwlines o]
+ Chnge Reqet by Asgnment G Change request is empty and. State ot n (Avalting Change Request, Under Implementation,
8 Change Requestby Assigiment Grou Exception- "
(©  Highand Citca,Patchable ulnerabilys  true g ML “‘:“’g" ik o Change Request [change_request] 10 false
by Operating System. Host Operating System contains windows
ange Request-Patchable
@ metepun-tuce false Host asset Qualys UUID is ot empty and. QID Patchable = true Change Request change_request] fatse
Actonsonsaectadrous v 1 tosofs

You can use the Copy this Rule option to clone the detection rule, modify the required
field, and save the rule with a new name. See Clone a detection rule.
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Review the existing values in the fields and modify as required:

@ = coo Updite  Delete A

¢ | = DetectionventRule
= Assets Tagged with Production and Tasks with Critical QDS Severity

Detection Event Rules

ul inserted
« Name: Aname to eference this rule by
« Actve: Isthis rule active or not?
« Source table: Trigger Criteria are met
« Destination Table: The table to create a record in when this ule s triggered.
When enabled, wil
ule.
Name . Tasks with C
At v Logging level Errors v
Sourcetable | Qualys - VMDR Task [x_quals_vmdr_vuln task it... v Enablegrouping |/
Destinationtable | Qualys-YMDR Task Group [x_quals_vmdr_vuln_... v
Source field to st to Dest None v

Group Tickets by QDS Severity

Source table - Select the Qualys - VMDR Task table, where the tasks are created when the
one-to-one detection rules are triggered.

Destination table - Select Qualys - VMDR Task Group. This is where the group task are
created when this rule is triggered.

For change request creation, select Change Request in the Destination table.

The Trigger Criteria tab defines the condition in which the detection event rule is
triggered.

Trigger Criteria
Below you can specify the criteria in which this rule should execute. This is based on data on each invidual record in th Source tableas they are processed.

= Order: The order In which this rule should run, in relation to the other rules for the same Source table
+ Stop Processing: When this rule s triggered, should we stop processing rules that are ordered after this one?
= Trigger when: This rule will be triggered the source record being Inserted or Updated matches the condition criteria spceified.

Order 100 Stop processing

Trigger when 5 records match condition 2

Add Filter Condition | Add "OR" Clause

All of these conditions must be met

Configurationitem.Supportgroup ¥ | Is notempty v aD  OR X
QID.Severity level v is one of v || 1-Negligible AND | OR X
2-Low
3- Medium
4-High -
Qualys Detection.Qualys detection ... v greater than v || 70 AND OR X
QIDVulnerability Type v is v Confirmed Vulnerability v AND = OR X
Host asset.Qualys Asset Tags ¥ || contains v || Windows Assets O, AND  OR | X

Order - Provide the number that indicates the order of priority for running this detection
event rule. The value in the Order field is a relative value and the detection event rules are
executed in ascending order, that is, lowest to highest. The order assigned to a rule helps
decide the priority when multiple rules exist for the same table.

Stop processing - Select this check box to stop processing the rules ordered after this rule
once the detection conditions are met.
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The Grouping defines how grouping is performed.

TriggerCriteria | Grouping = Assignment

Grouping Configuration

Configure h pel for this trigger rule. If Group bys not specified, will There are up to 4 that can be applied.

« Group by: Whatfield from the Source table should we group records by. Once a grouping is selected, additional fields will show If more grouping is needed up to 4.
« Stop grouping when: Specify a condition for the Destination record (Grouping Record) in which we should and create a New For example: [f you want to create a new Vulnerability Task when the original
grouping task s closed.

Groupby Configuration item v
Then group by Host asset Operating System v
Then group by Click to select... v

Stop Grouping When

Stop grouping when Add Filter Condition Add "OR" Clause
State v is one of v Open - AND OR X
Re Opened
In Progress
Under Investigation <

Group by - Select which field from the Source table should be used as a criteria for
grouping the tasks. You can select a criteria for grouping from the list

Select the element from the tree

[E GaQualys -VMDRTask
[E) Active
[ Activity due
[E)Actual end
) Actual start
[E) Additional assignee list
[F) Additional comments
) Approval
[E) Approval history
[F) Approval set
[E) Archive on
Cahssigned to
fassignment group

[F) Business duration

[ (aChange request
O\ Claca ot

You can define up to 4 criteria for grouping.

For details, on how the task grouping works, see Example of Grouping.

Note: Once you select a value in the Group by field, you cannot edit the value in the
field. To change value in the Group by field, click Clear Group By Fields. This clears
values in the Group by field.

The Clear Group By Fields option is available only if you have the required privileges.
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You can also define when the task grouping should be stopped. For example, the following
image displays that the task should not be included in a group if the state of the task
matches any of the selected values.

Stop Grouping When

Stop grouping when Add Filter Condition || Add "OR" Clause
Awalting Change Request -
State v is one of v Under Implementation AND || OR X
Change Implemented
Exception - Identified
-

Exception - Awaiting Approval

The Assignment tab defines how the assignment groups are assigned.

Trigger Criteria Grouping = Assignment

Assignment
How should the assignment group be set on the destination record? Note: This only applies if the destination table has an Assignment Group field.

« Assignment group based on: Select how the Assigment Group is determined on the destination record. This will only set the Assignment Group ifitis empty on the destination record.
© Ser Rules: Leverage builtin routing functionality.
© Detection Event Rule: Specify the assignment group to be used directly on this assignment rule.
© Group by fleldt If using grouping, and one of the Group by fields references the "Group” table, we will use the most specific grouping reference to the Group table [sys_user_group].
o Source Configuration Item Fleld: If the source record being processed has a reference to Configuration Item, select a field from that table/record to set the assignment group to.
« Assignment Group: What assignment group should be used.
© Based on Detection Event Rule: When assignment is based on Detection Event Rule tself, specify the assignment group to use.
o Based on Group by field: When assignment s based on Group by Field, this will be the Default Assignment Group if the group by field does not have one specified.

Assignment group based on ServiceNow Assignment Rules v

ServiceNow Assignment Rules

Detection Event Rule
Group by field

- If the Assignment group based on ServiceNow Assignment Rules is selected, the tasks
are assigned based on the rules set in the Configure Assignment Rules.

If the Assignment based on Detection Event Rule is selected, you can select a value in the
Assignment Group field. This assignment group will be applicable only for this rule.

If the Assignment based on Group by field is selected, you can select a value in the
Assignment Group field. This assignment group will be applicable only for this rule.

Click Submit to create a new detection event grouping rule.

Detection Event Field Maps
Once the detection event rule is created, add field mappings. Click the detection event
group rule that you created, and go to Detection event field maps.

You must add the following field mappings:

Detection event fieldmaps (2) | Assignmentrules  Detection Event Rules After this One  Versions (7) ~ Reprocessing Histories
= Delt(tmnevenlnemmansn Search | Coalesce v | search 1| t20f2 =]

? Detection event rule = Critical & High Vulnerability Tasks by Configuration Item

& Q = Source field = Destination field = Coalesce A
@  [lscript] priority false
@ [script short_description false
Actons on selected rows, ~ 1] t20f2
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Example of Grouping
This example presents how the Group by feature works. The grouping criteria is defined as

- Group by: Configuration Item.Support Group

- Then group by: Configuration Item.Business Criticality

- Then group by: Configuration Item.Operating System

There are 12 VMDR tasks with unique Configuration Item categorized as:

- Configuration Item support groups: Group A, Group B, and Group C

- Configuration Items with criticality: High and Low

- Operating Systems: Windows Server 2008 R2, RedHat, and Windows 11 22h02

The following scenarios explain how the task grouping is created. This explains how the
task groups are created in this example.

The tasks are first grouped by support groups as it is the first grouping criteria.
Scenario 1: Support Group A
Out of 12 VMDR tasks, the following four tasks belong to Configuration Item Group A.

VMDRTSKO0001 - CI.Support Group = Support Group A, AND a Business Criticality of High, AND a CI
Operating System of Windows Server 2008 R2

VMDRTSKO0002 - CI.Support Group = Support Group A, AND a Business Criticality of Low, AND a CI
Operating System of Windows Server 2008 R2

VMDRTSKO0003 - CI.Support Group = Support Group A, AND a Business Criticality of High, AND a CI
Operating System of Windows Server 2008 R2

VMDRTSKO0004 - CI.Support Group = Support Group A, AND a Business Criticality of High, AND a CI
Operating System of RedHat

In this case, the following task groups will be created:

Group Tasks included
VMDRGRPTSKO0001 - CI.Support Group = Support VMDRTSK0001

Group A, AND a Business Criticality of High, AND a VMDRTSKO0003
CI Operating System of Windows Server 2008 R2

VMDGRPTSKO0002 - CI.Support Group = Support VMDRTSK0002
Group A, AND a Business Criticality of Low, AND a
CI Operating System of Windows Server 2008 R2

VMDRGRPTSKO0003 - CI.Support Group = Support VMDRTSK0004
Group A, AND a Business Criticality of High, AND a
CI Operating System of RedHat

Scenario 2: Support Group B

Out of remaining tasks, the following two tasks belong to Configuration Item Support
Group B.
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VMDRTSKO0005 - CI.Support Group = Support Group B, AND a Business Criticality of Low, AND a CI
Operating System: RedHat

VMDRTSKO0006 - CI.Support Group = Support Group B, AND a Business Criticality of Low, AND a CI
Operating System: RedHat

In this case, the following task group will be created:

Group Tasks included

VMDRGRPTSK0004 - CI.Support Group = Support VMDRTSKO0005
Group B, AND a Business Criticality of Low, AND a VMDRTSK0006
CI Operating System: RedHat

Scenario 3: Support Group C
Remaining 6 tasks belong to Configuration Item support group C.

VMDRTSKO0007 - CI.Support Group = Support Group C, AND a Business Criticality of High, AND a CI
Operating System of Windows 11 22h02

VMDRTSKO0008 - CI.Support Group = Support Group C, AND a Business Criticality of Low, AND a CI
Operating System of Windows Server 2008 R2

VMDRTSKO0009 - CI.Support Group = Support Group C, AND a Business Criticality of High, AND a CI
Operating System of Windows Server 2008 R2

VMDRTSKO0010 - CI.Support Group = Support Group C, AND a Business Criticality of Low, AND a CI
Operating System of Windows Server 2008 R2

VMDRTSKO0011 - CL.Support Group = Support Group C, AND a Business Criticality of Low, AND a CI
Operating System of RedHat

VMDRTSKO0012 - CI.Support Group = Support Group C, AND a Business Criticality of High, AND a CI
Operating System of Windows 11 22h02

In this case, the following task groups will be created:

Group Tasks included

VMDRGRPTSKO00S - CI.Support Group = Support VMDRTSKO0007
Group C, AND a Business Criticality of High, AND a VMDRTSKO0012
CI Operating System of Windows 11 22h02

VMDRGRPTSKO0006 - CI.Support Group = Support VMDRTSK0008
Group C, AND a Business Criticality of Low, AND a VMDRTSK0010
CI Operating System of Windows Server 2008 R2

VMDRGRPTSKO0007 - CI.Support Group = Support VMDRTSK0009
Group C, AND a Business Criticality of High, AND a
CI Operating System of Windows Server 2008 R2

VMDRGRPTSKO008 - CI.Support Group = Support VMDRTSK0007
Group C, AND a Business Criticality of Low, AND a
CI Operating System of RedHat
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Reprocess the detection event rules

For importing new vulnerabilities, you need to process one-to-one detection rules
manually and subsequently the grouping rules also need to be processed again.

To reprocess the grouping rules and one-to-one rules manually, in the detection event
rule, click Reprocess Detection Event.

The Reprocess Detection Event option is available only if you have the required privileges.
If you cannot view this option, contact your ServiceNow administrator.

Clone a detection rule

You can create a clone of a grouping rule or one-to-one rule. Click Copy this Rule to create
a copy of the rule with all the defined settings along with detection event field maps.

You can provide a new name or save the rule with the default name. In this case, prefix
COPY is added to the existing name.

Configure Assignment Rules

The assignment rule defines the group to which the vulnerability task will be assigned
based on the group responsible for the remediation of the detected vulnerability. The tasks
are automatically assigned to the appropriate team based on the criteria defined.

Currently, all tasks are assigned to the Infrastructure team.

Note: We have provided an example of how an assignment rule is created. However,
you may not view this option as the permissions to create the assignment rule are
restricted. To get the assignment rules created, contact your ServiceNow
representative.

The following image displays the assignment rules available by default.

1| too0fo

n
z
EH
3 £
-t
o
S

= Name = Brecution Order & = User =6roup = Updated
Search Search Search Search Search

Windows Team 100 (empty) (empty) 20230131 08:42:15

Linux Vuln 100 (empty) Linux Server Team 2023.01-3108:42:15

@  xouals vmdr wiln task App Teams 100 (empty) (empty) 2023-01-3108:42:15

@  xouals vmdr wln task Aaure nfra 100 (empty) (empty) 2030131084215

Security Team 100 (empty) (empty) 2023.01.3108:42:14

AWS Infra Team 100 (empty) (empty) 2023.01-3108:42:15

App - Database Teams

100 (empty) (empty) 2023.01-3108:42:15

X quals vmdr vuln task WKS - Agent 100 (empty) (empty) 20230131 08:42:14

)  xquals vmdr win task test 100 (empty) (empty) 2023-02-06 143037

Actionsonsclectodrows... v 1] to9ofo

 Rosponsa timeims}: 4433, Network:,sarver: 3017, browser: 143

O —
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For example, the assignment rule for the Windows team:

[ < S R =

I ] Application [ Global ‘ o

Execution Order ‘ 101 ‘

Ative [V

wles To AssignTo  Script

Table ‘ Qualys - Vulnerability Task [x_quals_vmdr_vuln_task]

Conditons | dd Fiter Conditon H Add "OR" Clause

[Qualys Detection.Qualys Host.Oper... ¥ H contains

[t |[oe](=] []

[pae || oo

The assignment rule criteria for cloud assets:

Qualys Core

[ <=t

.
P, E o

Name ‘ Cloud Assets

Application [unab;sm H ® ‘
100 ‘ Adve (v

Execution Order [

Applies To mm‘l‘s script

Table Qualys Vulnerability Task [x_qual5_vmdr_vuln_task|

Conditions ‘ Add Filter Condition ” Add "OR" Clause ‘

All of these conditions must be met

‘QualysDemcﬂorl.Qualys HostTrac... ¥ H is oneof

v‘ NETBIOS i ‘ANDHORHX‘
AGENT !
‘ Qualys Detection.Qualys Host Asse... ¥ H greater than vH 800

‘ Update ‘ Delete
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To create a new assignment rule, go to Configuration > Assignment Rules, and click New.

— AssignmentRule =
< = Newrecord @ = e

Tec

ally assign tasks to d More Info

Name NewRule Application Qualys Core ®

Ative [/
AppliesTo | AssignTo  Script

Select aTable and specify the Conditions that must be met before the task is assigned to the user or group. The rule s applied only if the task i not already assigned to another user or group.

Table Qualys - Vulnerability Task [x_qual5_vmdr_vuln_task] v

Conditions AddFilter Condition | Add "OR" Clause

All of these conditions must be met

Tasktype v s v | Qualys-VunerabilityTask v mD | OR X
Description v || contains v an | or || x

Enter required details to create the assignment rule:

Name - Provide a name for the assignment rule.

Active - Select the Active check box to activate the assignment rule that you create.

Applies To - Define the conditions for the detected vulnerability for the task to be assigned

to the user or group.

Note: The assignment rule is applied only if the task is not already assigned to any

other user or group.

Table - Select Qualys - Vulnerability Task from the list.

Conditions - Define conditions using single or multiple attributes and filter for this
assignment rule.

The conditions can be selected based on your CMDB attributes such as, CI class, CI OS
type, CI location and zone, CI IP address range/CIDR, CI assignment group, and so on.

— Assignment ule =
¢ = 3 o

= Newrecord

assign tasks to d More Inf

Name

AppliesTo | AssignTo | Script
User

Group

NewRule

System Administrator

Vuln Routing Team

Application

Active
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Assign To - Select User or Group from the list to whom the task will be assigned.

¢ = AsignmentRule
= Newrecord

groups More Info

* The following script
*if (current.category == "Hardware")

add the Malware categ

t
*elseif (current.category =="Software")

Hardware");

*else f (current. category == "Malware")

fiware");

* Another Example:
* Release Planning Example, which assigns the last
* current release.product service assigned_to;

Name NewRule Application Qualys Core: ®
Acive v
AppliesTo | AssignTo | Script
| Entera scrpttofurther :_pool variables.
script i
* Example:

Script - You can enter a script to customize the assignment rules.

Click Submit to create the assignment rule.

View SLA Definition

You can view the service-level agreements (SLAs) defined for the different tasks. Go to
Configuration > SLA Definitions to view SLAs defined for different tasks created for

vulnerabilities detected by Qualys VMDR.

EI ? All>Table=x_quals_vmdr_vuln_task

O ShNamea
Search

ARS Criteria

Asset Risk Score

Cit Sev(4) NoRTI, Crit Buss Asset

Crit Sew(4), RTI-AT, High Buss Asset

Cit Sev(4), RTI-AT, Low Buss Asset.

Cuit Sev(4), RTI-AT, Med Buss Asset

Crit Sev(4), RTI-AT, Min Buss Asset

Cit Sew(5), No RTI, Crit Buss Asset

Cit Sew(5), RTI-AT, Crit Buss Asset

© 0| o e e 2| o @ ©

Crit Sev(5), RTI-AT, High Buss Asset

= | SLADefinitions m Search Name v Search

=Type

Search

= Target

Search

Resolution

Resolution

Resolution

Resolution

Resolution

Resolution

Resolution

Resolution

Resolution

Resolution

= Duration

Search

4Days

4Days

10Days

30Days

120 Days

60 Days

90Days

5Days

SDays

20Days

= Table

=x_qual5_vmdr_vuln_task

Qualys - Vulnerability Task [x_qual5_vmdr_vuln_task]

Qualys - Vulnerability Task [x_qual5_vmdr_vuln_task]

Qualys - Vulnerability Task [x_quals_vmdr_vuln_task]

Qualys - Vulnerability Task [x_qual5_vmdr_vuln_task]

Qualys - Vulnerability Task [x_quals_vmdr_vuln_task]

Qualys - Vulnerability Task [x_quals_vmdr_vuln_task]

Qualys - Vulnerability Task [x_qual5_vmdr_vuln_task]

Qualys - Vulnerability Task [x_qual5_vmdr_vuln_task]

Qualys - Vulnerability Task [x_quals_vmdr_vuln_task]

Qualys - Vulnerability Task [x_qual5_vmdr_vuln_task]

1 tol6ofl6

= Updated

Search

2022-06-2105:22:59

2022-06-2105:23:14

2022-06-21 04:13:02

2022-06-2104:14:34

2022-06-2104:19:44

2022-06-2104:15:28

2022-06-2104:18:16

2022-06-2104:11:36

2022-06-2104:12:35

2022-06-21 04:14:02
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The SLA definition is based on the Asset Criticality, Vulnerability Severity, Threat
Exposure, Qualys Real-Time Threat Indicators (RTIs), and CI mapping. The remediation
timelines are automatically measured according to the SLA definition.

Note: The SLA values are recommended values. To update the SLAs, contact your
ServiceNow representative.

The SLA Definition page displays the conditions in which the SLA is triggered, paused,
stopped, and reset.

(= 2;; Iz:q:;it;nn @ ' S coo Update  Delete N2
(D An SLA starting now will breach on 2022-09-26 14:00:00 (Actual elapsed time: 15 Days 2 Hours 24 Minutes) X ]
Name ARS Criteria Application Qualys VMDR for ITSM o)

Type SLA v Duration type User specified duration v
Target Resolution v % Duration Days 4 Hours 00 (00 (00
Table Qualys - Vulnerability Task [x_quals_vmdr_vu... ¥ Schedule source SLAdefinition v
Flow Default SLA flow Qe % Schedule 8-5 weekdays Q|0
Enable logging. Timezone source The caller's time zone v
Adive [V

Start condition | Pause condition ~ Stop condition  Reset condition
‘The conditions under which the new SLA will be attached and canceled

Start condition Add Filter Condition | Add "OR" Clause

All of these conditions must be met

Qualys Detection.QDS Severity v | isoneof v | [CRITICAL AND || OR | | X
HIGH
Low
MEDIUM
Qualys Detection.Qualys HostAsse... ¥ || s vils AND || OR | | X
Qualys Detection.Qualys HostAsse... ¥ || greater than v o0 AND | OR || X
Retroactive start
When to cancel Cancel conditions are met e
Cancel condition Add Filter Condition | Add "OR" Clause -

These conditions are based on Vulnerability Status (New, Active, Fixed, Reopened) and
Vulnerability State (Open, In progress, In review, Change implemented, Resolved, and so
on).

- The vulnerability states included in the Start condition are Open, In-Progress, In-Review,
Under Investigation, and Reopened.

- The vulnerability states included in the Pause condition are Awaiting Change Request,
Under Implementation, Change Implemented, Awaiting Exception Approval, Exception
Approved, and False Positive — Approved.

- The vulnerability states included in the Stop condition are Closed and Resolved.

Examples of SLA definitions
SLA based on Asset Risk Score
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== SLA Definition —
< = RssetRisk Score P VS o Update | Deete
Name Asset Risk Score Application Qualys Core 6]
Type stA ~ Duration type User specified duration ~
Target Resolution ~ % Duration Days |4 Hours | 00 00 00
Table Qualys - Vulnerability Task [x_qual5_vmdr_vuln_... v Schedule source SLA definition ~
Flow | DefaultSLA flow alle % Schedule | 20x7 vio
Timezonesource | The callers time zone v
Active V|
Awil
Sartcondiion | Add Filter Condition || Add "OR" Clause
Allofthese conditions must be met
Qualys Detection.QID.Severitylevel v || isone of v || 1-Negligible < AND || OR
2-low 1
3-Medium
4-High -
Qualys Detection.Qualys Host Asse... ¥ greater than » 850 AND OR x
Qualys Detection. Qualys HostAsse... v || is “lls AND | OR | | X%
Qualys Detection.Qualys detection ... w || greaterthan v 0 AND || OR | | X
Qualys Detection.Qualys Host.Qual... v || contains ~ | Intemet FacingAssets Q| |am | or | |x
< | = intemetFacingAsset @ T e pdae Delete
Name | Intemet FacingAsset Application | Qualys Core ©
Type st v Duration type User specified duration v
Target | Resolution “ * Dumtion | Days |2 Hous 00 00 00
Table | Qualys-Vulnerability Task [x_quals_vmdr_vuln_... ¥ Schedulesource | SLAdefinition v
Flow | Default SLAflow alle % Schedule | 24x7 vle®
Enable logging Timezone souce | The caller's time zone v

Adive v/

Start condition Add Filter Condition | Add "OR" Clause

Allof these conditions must be met

Qualys Detection.Qualys detection .. v || greater than v i AND || OR | X

Qualys Detection.Qualys Host Qual... ¥ || contains ~ || Intemet FacingAssets

Qualys Detection.Qualys HostAsse... v || greaterthan v 80 anp || or || X
Qualys Detection.QDS Severity v | isoneof v || [CRICAL - AND || OR
HIGH
Low
MEDIUM v
Qualys Detection.Qualys HostAsse... v || greater than v AND || OR || X
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Activate SLA

By default, the SLAs are not activated. To activate an SLA, click an SLA definition, set the
Duration Type and Schedule fields, and click Update.

= SLA Definition
< | = Crivsevid), RT1AT, Min Buss Asset & N oo Updwe  Swve  Delere A

n the Qualys VMDR for ServiceNow ITSM applic feancel)

() An SLA starting now will braach on 07-18-2022 15:37:18 (Actual elapsed time: 90 Days) b4

Name it Sev(4), RTIAL Min Buss Asse Application(sys_scope) Qualys VMDR for ServiceNow 1 TSM

Type LA 4 User specified duration ~

Table  Qualys-Vulnerability Task [x_quals_vmdr_vuln... ¥ Days %0 Hours 00

Workflow None v Schedule source SLA definition v

Acive v * Schedule 24x7

Enable logging imezane source The caller's time zone -

Configure Patch Deployment Settings

You can configure settings for the patch deployment jobs, such as, maximum number of
assets that can be included in the patch deployment job, percentage of completion that
can be considered for job completion.

To configure Patch job deployment, go to Qualys Core > Configuration > General Settings.

— Genenisetings
<= &

i

Qualys Core

1fyou experlence Issues:

Patch Deployment Configuration v

Patch Deployment Configuration

Job: Adjust the number of Job. time.
H d-Stale”

- Percentage of completed items to consider Patch Deployment completed - If the
percentage of assets where the patch job is deployed reaches the defined number, the
patch job is considered as completed.

- Maximum Number of Assets Per Job - Define the number of assets to be included in a
single patch deployment job. For example, this field is set to 50. If there are 100 assets per
change ticket, two patch jobs are created for 50 assets each to ensure that only specific
number of assets are added to the patch jobs.

- Duration Past Start Date to Auto Complete - The time elapsed after the patch job has
started. After the time defined in this field, the patch job is considered as stale and the
state of the patch job changes to Completed - Stale.
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The default settings are available in the Patch Deployment Configuration. However, you
can modify the values and click Update.

Customize Data List Columns

We display few columns in the data lists. You can customize which columns appear and
change the column sequence. The following example presents how to add a column to the
displayed list of columns.

1) Click the icon in the main pane. The Personalize List Columns pop-up appears.

Personalize List Columns )4
Available Selected
Connector Number
Created Data Transfer Definition
Created by State
Duration Job Started
Import Configuration Total Records
Import Set Percent Complete
Log b3 Job Stopped ~
Metadata Duration (seconds)
Since < Updated o
Status Message
Tags
Updates

Workflow Context

+ | Wrap column text Compact rows Active row highlighting
+ | Modern cell coloring

+ Enablelistedit |+~ Double click toedit

2) The Available list includes columns that are currently hidden. From this list, select the
column you want to display. For example, double-click the column “Updated by” and you
will see it moved to the Selected list.

3) Enable or disable other settings like Wrap column text, Double click to edit, and so on.
4) Click OK.

You'll start seeing the Updated by column. If for some columns, the data is not available,
the value in the column will be empty.
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Qualys VMDR

Qualys VMDR application manages tracking of open vulnerabilities and mapping of
remediation tickets to the respective resolver groups.

In Summary

Hosts/Assets: View details of assets and match or create CI records.

VMDR Task Groups: View details of vulnerability task groups created.

VMDR Tasks: View details of all vulnerability tasks created.

Launch a VM Scan: Launch a VM scan from Qualys VMDR application.

Exceptions: View details of initiating exception request and approval workflow.
False Positive: View details of initiating false positive request and approval workflow.
Scan Executions: List of scan executions that are initiated from this application.
Detections: List of all vulnerability detections categorized based on status.

Qualys Patch Management Workflow - View change request management process.
Reports and Dashboards: View different reports and dashboards.

KnowledgeBase: View Qualys knowledgebase.

Hosts/Assets

When data is imported as a part of the integration, the Qualys VMDR automatically uses
host (asset) data to search for matches in the ServiceNow Configuration Management
Database (CMDB).

CI lookup rules are used to identify CI and add them to host detection records when
vulnerability tasks are created to help you with remediation.

Qualys - Host Assets m Search Name ¥ | Search 1 to200f270967 B PP

T A

&g

O, =Namea SAsetld ScConfigurationitem  SQualysid ~ EIPvse  SIPve I LastVulnerabilityScanDate = Netbios SNetworkld = Hostnam
W Detections Search Search Search Search Search Search Search Search Search Search

New

@

(empty) 406933792 (empty) (empty) 41223

Active

6

(empty) 417179677 (empty) (empty) 41223
Re-Opened

6

(empty) 416905670 (empty) ] (empty) 41223
Fixed

@

All (empty) 408719516 (empty) ! (empty) | 41223

W Hosts / Assets

@

(empty) 436572773 (empty) 4 (empty) 41223

All

@

(empty) 192610746 (empty) ] (empty) 41223
Cl-Matched

@

(empty) 402843144 (empty) 1 3 (empty) 41223
CI-Unmatched

@

(empty) 437887960 (empty) spconem (empty) 41223

'V Knowledge Base

Confirmed

e

(empty) 403222935 (empty) 3 g (empty) 41223

All

@

(empty) 458400765 (empty) ) (empty) 41223
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- CI-Matched - If the IP address or host that is scanned in Qualys is part of ServiceNow
CMDB, the same is categorized as matched CI. The vulnerability task created for this hosts
or assets is assigned according to the defined assignment rules.

- Cl-Unmatched - The host or asset is categorized as unmatched CI in one of the following
conditions:

- IP address or host that is scanned in Qualys is not available in CMDB
- IRE scripts attributes do not match
- Duplicate records of IP address or host are found in CMDB.

The vulnerability task is created for this host or asset and is assigned to your Security
team.

Note: To maximize the Host Asset records matching with CMDB CI records, enable
the CI re-classification during IRE processing.

For Identification and Reconciliation, following properties are used to control the re-

classification, and to identify the CI records:

- glide.class.upgrade.enabled

- glide.class.downgrade.enabled

- glide.class.switch.enabled

For more information, click here.

Set these properties as True to maximize the Host Asset records matching with CMDB CI
records.

Find CI

For unmatched CI, you can find the CI availability by using the ServiceNow functionality -
Identification and Reconciliation Engine (IRE).

The Identification and Reconciliation Engine (IRE) tries to find the associated CI based on
other matching criteria, such as, Host Name, DNS Name, FQDN, Domain, IP address, and
Netbios.
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To find associated CI, open an unmatched CI record, and click Find CI.

=== Qualys - Host Asset

< = *psplchs 26112 Va ':—__. coo Update | CreateCl  FindCl
Name
Tracking method IP v Asset|d
Configuration item Q. Qualys Id
Operating System Windows XP

Qualys Asset Tags

Asset Groups

Network = Scan Dates

Host name

DNS Name

FQDN

Domain

Netbios

&

DECOM Asset+365days, Win Workstation, TestIP to remove, FJJ-Windows tracked by IP, MCW - AT Not Seen in 180 Days, OS: Windows
Workstation, Sullivan_Test_Tag_Windows, Not Scanned in 365 days, MCW - Not 38601, 1 AC Demo Business Unit, SF - Windows
Workstations

&  MEP-QA, MEP - ACS Test, TM - Global Network, AllIP in subscription, TestlP to remove, PB - 10/8, SMC - Assets to Purge

Cloud = ARS Factors

Network Id 0

IPv4

IPv6

Qualys VMDR

Delete

™~

-

If any parameter matches the corresponding values in CMDB, the Configuration item field
is automatically populated. Click Update to update the record.

To find the CI, a script is used that is available under System Definition - Script Includes -

QualysAssetIRE.
IRE CMDB CI hardware cirteria: (Script Includes,
Definition & look for QualysAssetIREvar ireData = {
items: [{

className:

"cmdb ci hardware",

values: {

os: host.getValue ('operating system') || undefined,
name: host.getValue('name') || undefined,

asset tag: host.getValue('asset id') || undefined,
dns_domain: host.getValue('domain') || undefined,
fgdn: host.getValue('fgdn') || undefined,

ip_address: host.getValue ('ip_ address') || undefined,
}

}H]

}i

under System

You can modify the IRE parameters and the script with additional parameters if you have
required privileges.
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Note: Ensure that you have defined the Hardware Rule in the Identification and
Reconciliation Engine and the criteria to be matched are set to true.

To check the hardware rule, go to Identification/ Reconciliation > Cl Identifiers > Hardware

Rule.
(= Ic?wi“ggﬁ;r,hardware J '\/\' :___' Eaal Update baER \l/
Name Hardware Rule Active | -
>k Appliesto  Hardware [emdb_ci_hardware] v
Description Identifier for hardware.

Independent
Update Delete
Identifier Entries (10) =~ Related Entries (8)
=  Identifier Entries m Search  Active ¥ | Search 1 to10of10 B

? Identifier = cmdb_ci_hardware

@ O\ = Active ¥ = Search on table = Criterion attributes = Allow null attribute = Optional condition = Priority
Hardware
@ true N ip_address,mac_address false 500
[emdb_ci_hardware]

@ true Hardware name false 300
[cmdb_ci_hardware]

Network Adapter
@ true

mac_address,name false install_status!=100*E 400
[emdb_ci_network_adapter] - - Q

Note: The CI matching can be enhanced with the Qualys CMDB Sync app available
on the ServiceNow store. The Qualys CMDB Sync app is part of Qualys CyberSecurity
Asset Management (CSAM). For more information on Qualys CMDB Sync app,
contact your Qualys representative.
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Create CI
If there is no matching CI found in CMDB by using the IRE, you can create a new CI record.

To create a new Cl record, open an umatched CI record, and click Create CI. The
Configuration item field is populated with the CI value.

¢ == Qualys-HostAsset
= 10115

o & = ooo Update CreateCl  FindCl | Delete N

Name 101151
Tracking method P v Assetld
Configuration item Q Qualysid
Qualys UUID
Operating System Euler0S / Ubuntu / Fedora / Tiny Core Linux /L
Qualys Asset Tags &

No NetBIOS Name, p1_Operational, Scan Time (&gt;15m), IP: 10.0.0.0_8, SW: EOL EOS Software, Status:Operational, Crash_TCP_Unknown, Authentication Not Attempted, EOL,
Scanned In 180-D, Scan Time (&gt;45m), OS: Unidentified, CPE Tag Example, Scanned In 90-D, Scan Time (gt;30m), Scanned In 30-D, BU-NET-RDLABS_INDIA, No Hostname
not_scanned_x_days, TM: IP Tracking

Asset Groups & BU-NET-RDLABS_INDIA

Network = ScanDates Cloud TruRisk

Hostname Network Id TT7124
DNS Name 1P v4 10.115.1
FQDN IP V6
Domain
Netbios

Update | CreateCl  FindCl  Delete

Click Update to save the record.

View and Manage Vulnerability Tasks

When the detection event rule provided in the Qualys Core application is processed,
vulnerability tasks or task groups are created for the host detections that are imported.
You can view and update the vulnerability tasks that are created.
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Qualys = Qualys»vulnerzh‘\lilyTasksu Search  State v | Search W 1 to200fs5065 B PP
= * @y
& O SNumber  SState A I Severitylevel = Priority =Pva = Vulnerability Status = Assignment group SAssignedto = Operating System =aqp
Qualys VMDR for ServiceNow ITSM
Search Search Search Search Search Search Search Search Search Searct
Overview
W Vulnerabilty Taks (@  VIASKoo7e682 Open 4-High 2-High gt Active Vulnerability Routing (empty) Solaris 9-11 120356
julnerability Tas!
Open
Assigned to My Group (Open)
(D VIASK0020803 Open 3-Medium 3-Moderate Fixed Vulnerability Routing ~~ (empty) Ubuntu Linux 16,046 197917
Assigned to My Group (Fixed)
Assigned to Me (Open)
Al
@©  vIask Open 4-High 2-High Active Vulnerability Routing (empty) Z’e""jf:‘;:iojsewyw 100232

You can view the tasks categorized based on task assignment, that is, tasks assigned to
you and your group, based on status of the tasks, that is, open or fixed.

Note:
- The administrators can view all vulnerability tasks in all statuses.
- If you are a part of a remediation team, you can view only the tasks that are

assigned to your own group.

View Vulnerability Task Details
You can view list of all the vulnerability tasks that are created in the application.

= | Qualys - Vulnerability Tasks m Search  State ' V“ 1  to200f55065 P PP

<
= T oA
f'o:‘z O, = Number =State A = Severity level = Priority =ipva =w ility Status = Assi = Assignedto = Operating System =qQD = Title
Search Search Search Search Search Search Search Search Search Search Search
Solaris SC
()  \VIASK0079682 Open 4-High 2-High Active Vulnerability Routing (empty) Solaris 9-11 1 Remote L
Service Vi
Ubuntu S
Notificati
Linux-aw:
(i)  VIASK0020803 Open 3- Medium 3-Moderate 35 Fixed Vulnerability Routing (empty) Ubuntu Linux 16.04.6 E aws-hwe,
azure, Lin
415, Linu
(USN-439
Microsoft
Windows 2003 Server AD Explorer (
()  \VIASKo0S3632 Open 4 High 2-High Active Vulnerability Routing ~ (empty) S:"M:“;ac“ el g 592\:3&
(MS15-04
Apple Saf
. . Windows XP Service S and.s
(D VIASKoos1192 Open 4_High 2-High Fixed Vulnerability Routing (empty) Packs 3 Vulnerabi
(APPLESS,
20-1)
Microsoft
Explorer (
Wind: Si 2003 64 " il
(@  VIASKoo49094 Open 3 Medium 3-Moderate Active VulnersbilityRouting ~ (empty) hici e} ] s B
—
»
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You can click a vulnerability task number to view details of the vulnerability task. You can
view the basic information of a vulnerability task, such as, task number and status,
Qualys detection ID, associated connector, status of the vulnerability, and assignment

details.
< | = ok &P V5 oo Fllow - Update Delete AN,
Number VTITMO012378 State Awaiting Change Request ~
Connector Qualys Demo Account o) Vulnerability Status Active
3k Qualys Detection HDETCT0986629 o Severity level 4-High
' Automated - Qualys Integrati v > Change request CHG1821422 Q| ®
Configuration item Q Assignment group Q
Class NET Application Assigned to Q
Status - None — QDS Severity HIGH
Qualys detection score 81
Host Information provides host and host network information.
Host Information Host Network Information
Operating System Windows 11 Pro 64 bit Edition Version 21H2 1Pvd 10.115
Cloud Resource ID IPv6
Asset id 52618 Host name desktop-| ~
Qualys 1d 4261 Netbios DESKTOP-|
TruRisk Criticality Score 2 FQDN desktop-k
TruRisk Score 340 DNS Name desktop-k
Domain europa.
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Vulnerability Details provides details of a vulnerability that is available from Qualys

VMDR.

< | = b Vuinerabithy Teck A N e o T N
Vulnerability Details = Detection =~ Notes / Activity B
Title Solaris SCTP and IPv6 Remote Denial of Service Vulnerability
Vulnerability Type Confirmed Vulnerability QID 120356
Cvss CVssv3
CVSS Base 78 CVSSv3Base 75
CVSS Temporal 538 CVSS v3 Temporal 65
Threat Unspecified vulnerability in Oracle Solaris SCTP and IPv6 component allows remote attacker to cause a denial of service.
Affected Versions:
Solaris 8,9, 10 on the SPARC and x86 platforms is affected.
impact  Successfully exploiting these vlnerabilities might allow remote attacker to cause denial of service.
Solution Refer to Oracle CPU Jul 2012 for Sun Products and Oracle Sun Products Suite Executive Summary Section at Oracle CPU JUL2012 to address this issue
and obtain more information.
Patch:
Following are links for downloading patches to fix the vulnerabilities:
Oracle Solaris CPU Jul 2012:Solaris 8,9, 10

The Detection tab provides the detection logic, type of vulnerability, tracking method and
results of the detection.

<= Qualys - Vulnerability Task

= VTASK0079682

Vulnerability Details =~ Detection

Qualys Asset Tags

Asset Groups

Detection Detail

Tracking method
Service
Port

Protocol

Results

Notes / Activity

Delete

R 2

Follow -

& W
2 o
=

Update

DECOM Asset+365days, TestIP to remove, MMC Test Environment, ScanTimeMin-0-30, MCW - AT Not Seen in 180 Days, PB - 10/8, Qualys - QA Lab - Solaris
10, MAK Groovy, MCW - Not Scanned in 30 Days, MCW - Auth Not Attempted Windows, External facing ports, MSC-LAB, hs-Service-SQL-Tag, Unix - PP, Not
Scanned in 365 days, MEP - QA, ScanTimeMin-0-10, SMC - Default Demo Assets, MCW - Not 38601, 1 AC Demo Business Unit, MCW - Test OS CPE, Public
DMZ, YK-Threat Protect, Server0S, Test Purging - GTD, (TVL) Linux

Public DMZ, MEP - QA, TM - Global Network, TestlP to remove, SMC - Default Demo Assets, Unix - PP, YK-Threat Protect, PB - 10/8, MMC Test
Envirenment, Qualys - QA Lab - Solaris 10, MSC-LAB

P Type Confirmed
Affect Exploitable Config - None —
Affect Running Kernel —None —
Affect Running Service —None -
Is disabled
Isignored |
Detected over SSL

SUNWcslis installed
147441-15 is missing.
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The Detection tab also provides details of scan dates.

Scan Dates

Last Vulnerability Scan Date

2019-10-02 01:02:42

Last Unauthenticated scan

2019-10-02 01:02:42

date
Last Authenticated scan date 2019-08-19 11:07:17
Last VM (UnAuthed) Scan 0 00 00 00
Duration
Last Authed Scan Date 0 00 00 00
Duration

Last Compliance Scan
Date/Time

2020-03-23 07:58:49

Last Compliance Scap Scan
Date/Time

Update Delete

Related Links

Launch VM Scan
Show SLA Timeline

You can add notes to the ticket in the Notes/Activity tab. Any changes or updates in the
task is also seen in the Notes/Activity tab.

< = Qualys-Vulnerably Task @ VN = oo Follow - Update  Delete N2
Vulnerability Details ~ Detection  Notes / Activity -~
Work notes Work notes
Post
Activities: 1
System Field changes - 2021-11-01 15:53:17
Impact  3-Low
Openedby  [Empty]
Priority ~ 2-High
State  Open
Update Delete
Related Links
Launch VM Scan
Show SLA Timeline
On the vulnerability task page, you can also view additional details, such as, recent
vulnerability scans, other open tasks on the same host, open tasks for the vulnerability
that is selected, and SLA for the selected task.
Recent VM Scans for Host ~ Open Tasks for Host (51) = Open Tasks for Vulnerability (1) | Task SLAs (1)
=  Open Tasks for Vulnerability m Search  State ¥ | Search 1 tolofl B
5 Qualys - Vulnerability Tasks
i Q, = Number =sState A = Severity level =IPvs = ility Statu: =c ion item = Class. = Status = Assignment group = Assigned to =
(D VTASK0074064 Open ® 5-Critical Fixed (empty) Vulnerability Routing (empty) AD
Actions on selected rows... -« 1 tolofl
4 »
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Update Task

You can update the state of the task to Resolved. When the status of the vulnerability is
fixed, the task state is automatically updated to Closed.

You can check whether the vulnerability is remediated completely in the following ways.

- If the vulnerability is detected by the Qualys agent, the agent keeps polling every four
hours. If the vulnerability is remediated, the status of the vulnerability is updated to
Fixed.

- If the vulnerability is detected by a virtual scanner, the change in the vulnerability status
is updated in the next scanning.

Launch a VM Scan

You can launch vulnerability scans from the Qualys VMDR application to verify whether a
vulnerability is fixed.

Note: Currently, we perform scans for detection of all QIDs. We are not supporting
scan for a selected vulnerability at the QID level.

We can launch a Qualys VM scan in following ways:
- For a single vulnerability task

You can click Launch VM Scan from the Related Links in the vulnerability task.

Launch a Qualys VM Scan

Host Information
Please review the host information and details before launching your scan
Name IPva
aix61-30-211 10.10.30.211
Tracking method Qualys Asset Tags
P DECOM Asset+365days, JM Asset Group 2, TestIP to remove, ScanTimel
Asset Groups

Public DMZ, AIX, MEP - QA, TM - Global Network, TestIP to remove, DC -

Scan Configuration
Please select the Scanner Appliance and Option Profile for this can. Note: The defaults have been loaded for the Connector associated to these hosts.
Scanner Appliance Option Profile

is_quays_ma58_2 Xv MCW - Std VM Scan - No Auth - Fast - Web QIDs Only Xv

=

You can select the Scanner Appliance and Option Profile from the list and click Start Scan.
We recommend you to use the default option profile that is configured and populated. If
authentication is missed, vulnerability detection may not be accurate. If the vulnerability
status is changed to Fixed in the scan, the task will get closed automatically.
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Note: If the tracking method for the host is Cloud Agent, Cloud Assets, DNS tracked,
NetBIOS tracked, or FQDN, you cannot launch a VM scan.

Launch a Qualys VM Scan X

Host Information
Please review the host information and details before launching your scan
1Valid Hosts for Scan

The following Hosts are valid to launch a VM Scan against.
® 64.41.200.250 | demo20.502.sjc01.qualys.com | IP

1Invalid Hosts for Scan

The following Hosts are not valid targets to Launch a VM Scan from ServiceNow. This is typically due to the Tracking Method as only IP based Tracking methods
are currently supported. Please consider refining your List Filter 7

® 64.41.200.250 | demo020.502.sjc01.qualys.com | DNS (D)
Scan Configuration

Please select the Scanner Appliance and Option Profile for this can. Note: The defaults have been loaded for the Connector associated to these hosts.

Scanner Appliance Option Profile

is_quays_ma58_2 Xv MCW - Std VM Scan - No Auth - Fast - Web QIDs Only Xv

- For multiple vulnerability tasks

a
=  Qualys- Vulnerability Tasks m Search  State ¥ | Search W 1| to200f55065 B BB
b =Number ~ =State A  =Severitylevel ~ =Priority =IPv4 = VulnerabilityStatus = Assignmentgroup ~ Assignedto = Operating System =qQD =Title
Microsort
Windows XP Service Print Spo
VTASK0042530 Open 3-Medium 3-Moderate Fixed Vulnerability Routing (e 90508
0 P Vulnerability Routiog (empty) Pack3 Allow Rer
Executior
Ubuntu'
Notificati
@ VTASK0089474 Open 3-Medium 3-Moderate 42 Fixed Vulnerability Routing (empty) Ubuntu Linux 16.04.6 198108 Freetype
Vulnerabi
4593-1)
‘Actions on selected rows. N Adobe Fl:
Add to Update Set Windows XP 64 bit Cross-Sit
v Delete 3-Medium 3-Moderate Fixed Vulnerability Routing (empty) 5 119314
B Edition Service Pack 2 Vulnerabi
Follow on Live Feed
(APSBL1-
YALA Show Matching Checked
Repair SLAS Microsoft
Add to Visual Task Board Wind s 2008 R2 Shell Rem
indows Server
v Create Application File ® 5 Critical ® 1-Critical Fixed Vulnerability Routing (empty) i ) 91029 Executior
AssignTog: Enterprise 64 bit...
Vulnerabi
New tag.
Performance Analytics and Reporting 020)
IT Service Management
Customer Service Solaris I
IT Operations Management. Input Vali
v Software Asset Management 3-Medium 3-Moderate Active Vulnerability Routing (empty) Solaris 9-11 120149 Vulnerabi
Cannot determine code change
Other Apache H
Includes code 20
More.... v
Actions on selected rows... v 1 to200f55085 P PP
(:j Response time(ms): 1164, Network: 4, server: 1027, browser: 133
4 >

You can select multiple vulnerability tasks and select Launch VM Scan from the list of
available actions.
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= Qualys-HadAssﬂsm Search | 1Pv2 v

Performance Analytics and Reporting

IT Service Management

4 Customer Service (empty)
IT Operations Management

Software Assat Management

. Cannot determine code change (empty)
Other
includes code
L4 More... (empty)
Remove Tag: -
Actions on selected rows... v ]

32 = Name = Assetld = Configuration item = Qualysid
(O (empty)
=" "1t phingtonde-
@ phingt (empty)
® (empty) |
74-92-153-1-
; » (empty)
‘Actions on selected rows. S o
Add to Update Set
o (empty)
e L
Find CI
YALA Show Matching Checked L (empty)
Create Application File
Assign Tag:
b New tag (empty)

=IPvd A

= Last Vulnerability Scan Date

2015-09-15 17:58:43

2021-11-09 20:32:54

2012-04-18 06:23:09

2021-11-09 18:43:49

2021-11-09 19:46:49

2021-11-09 18:42:26

(empty)

(empty)

2015-12-16 16:42:07

(empty)

44 4« 270,9. | t6270,947 of 270967 B PP

PILO

UNKNOWN 0

UNKNOWN 0

< <

= Netbios = Network Id = Hostnam

270,9: | to 270,947 of 270,967 B PP

You can select multiple host assets from Host Assets or from Host/ Assets and select

Launch VM Scan from the list of available actions.

- For Host Detections

= Qualys- Host Detections m Search Number

(D  HDEICT0700389 (empty)
(D  HDEICT0700388 (i (empty)
Actions on selected rows... ~ | (empty)
Add to Update Set
Delete

YALA Show Matching Checked (empty)
Create Application File
Assign Tag:

v New tag, (empty)

performance Analytics and Reporting
IT Service Management

n Custumerl Service (empw)
IT Operations Management
Software Asset Management
Cannot determine code change

v Other (empty)
Includes code
More..
Remove Tag: (em pty)

Performance Analytics and Reporting
IT Service Management

Actions on selected rows... v

@ = Number ¥ =QiD = Configuration item

¥ | Search

{empty)

(empty)

(empty)

{empty)

(empty)

(empty)

(empty)

(empty)

= Qualys Host

= Protocol

= Service = Vulnerability Status = First founc

Active

Active

Active

Active

Active

Active

Active

Active

1 t0200f267,082 p PP

511205

2021-11-10
09:40:06

2021-10-20
20:40:16

2021-09-24
10:01:36

2021-09-15
12:01:01

2021-07-21
21:36:54

2021-07-14
10:02:04

2022-01-26
06:18:45

2021-06-14
11:57:43

1 to200f267,083 B PP

You can select multiple host assets from Host Detection or from Detections and select

Launch VM Scan from the list of available actions.
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VMDR Task Groups

For effective management of vulnerability tasks, you can group the individual
vulnerability tasks based on multiple factors, such as, Vuln Severity, multiple Qualys
Knowledgebase fields, Qualys Detection Score (QDS), QDS Severity, Asset Risk Score (ARS),
Asset Criticality Score (ACS), Operating System, Qualys Asset Tags, Assignment Group,
Configuration Item, and so on. Qualys VMDR creates tasks groups based on the Grouping
Rules configured in Qualys Core and assigns them to the remediation team based on the
defined assignment rules.

Vulnerability task grouping provides better visibility to the remediation owners to track
remediation with fewer tasks and quicker remediations, organizes vulnerability tasks, and
analyze them in bulk.

You can view vulnerability task groups that are assigned to you and your group as a
remediation owner.

For each task group, you can view the state and priority of the task group, the assignment
group, the number of vulnerability tasks included in the task group, percentage of
remediation, and so on.

= Qualys'VMDRhskaupsm Search | % Vulnerability Tasks remediated v | Search W 1 to200f2552 B PP

= ? All > Active=true

& O Shumber  Ssute = Assi = =96 Vulnerability Tasks remediated v == Vulnerability Tasks = Total Vulnerability Tasks = Tots

Search Search Search Search Search Search Search Searc
(D VIGRPOGRIS2S Awaiting Change Request Developer Critical & High Vulnerability Tasks by C1 Support Group 1000 3 o
()  VIGRPOIZI00 Open Developer (ritical & High Vulnerabilty Tasks by CI Support Group 1000 I 1 0
® Confirmataion Vulnerability Team - Critical & High Vulnerability Tasks by C1 Support Group 94.16% I 0 23
@ Awaiting Team Fireball Comets Critical & High Vulnerability Tasks by Cl Support Group 90.26% [ 343 39
()  VIcRPoe2134 Open ‘Apache Support Group Critical & High Vulnerability Tasks by CI Support Group g5.710 [ 1 &
@® v Awaiting Windows Server support Critical & High Vulnerability Tasks by CI Support Group 70v 7 3
()  VIGRPOO2ISSS Exception - Identified App-Sec Manager (ritical & High Vulnerabilty Tasks by CI Support Group 635705 n ®
() VIGRPOO21S2T Exception -Identiied VMDR Remediation Analysts ritcal & High Vulnerabilty Tasks by CI Support Group 54970 N 68 8
()  VIGRPU21538 Awaiting Change Request Application Security ritcal & High Vulnerabilty Tasks by C1 Support Group s3.050 7 3
()  VIGRPUIZTEEL Open VMDR Admins rtical & High Vulnerabilty Tasks by CI Support Group 33.330 4 4
()  VIGRPOIERS5 Open UMDR Admins (ritical & High Vulnerabilty Tasks by CI Support Group 1161% Il 9 B
()  VIGRPOlea465 Open Developer ritcal & High Vulnerabilty Tasks by CI Support Group 1081% Il 198 2
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For each vulnerability task group, you can view the following details:
¢ = Qualys-VMDR Task Group - VIGRPOO B ovo Follow |~ update AN
Number VTGRPOC State Awaiting Change Request v &
> Priority 1-Critical v Changerequest
Assignment group Windows Server support Qo |l e
Assigned to o,
shortdescription Vulnerability Tasks for support group: Windows Server support I B
Description

Remediation Status | Notes /Activity ~ Group Definition

Include Deferred
Vulnerability Tasks 7 9% Vulnerability Tasks remediated 70

Total Vulnerability Tasks 10

Exclude Deferred
Vulnerability Tasks 0 9% Vulnerability Tasks remediated 0

Total Vulnerability Tasks 3

You can view the basic information of a vulnerability group task, such as, task number
and status, assignment group and priority.

The Remediation Status provides remediation status as number of tasks, including and
excluding the deferred tasks and percentage of tasks remediated.

Remediation Status | Notes /Activity = Group Definition

Include Deferred
Vulnerability Tasks 7 9% Vulnerability Tasks remediated 70

Total Vulnerability Tasks 10

Exclude Deferred
Vulnerability Tasks 0 9% Vulnerability Tasks remediated 0

Total Vulnerability Tasks 3

Update

The Group Definition displays the detection event rule that was applied for creating this
group task.
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< = Qualys-VMDR Task Group - VIGRPO Vs Follow |~ update A 4,
Number VTGRPO! State Awaiting Change Request ~ .
>k Priority 1-Critical ~ Change request
Assignment group Windows Server support [*Sio]

Assigned to

Short description Vulnerability Tasks for support group: Windows Server support

P
Edl

Description

Remediation Status = Notes/Activity  Group Definition

Detection event Critical & High Vulnerability Tasks by Cl Support Group

Update

The task groups also displays details about the deferred and resolved tasks, host assets
involved in the group task, QIDs associated with the this group task.

Deferred Tasks

Open Tasks (6) | Deferred Tasks (1) | Resolved Tasks (3) ~ Host Assets (Unique) (1) = QIDs (Unique) (10) ~Approvals ~Task SLAS

= DeferredTasks Search Number v | search << <« 1]to1of1 > PP H

S Grouped vulnerability Task

Number tate

rity ‘onfiguration item Host asset Operating System Assignment group Detection event
False Positive Windows Server 2008R2  VMDR Windows o —

@  viask ® 1-Critical 105972 r—— (empty) Vulnerabili
- Confirmed ymdr Enterprise 64 bit.. Vulnerability Team c

Actions on selected rows... v 1] tolof1

Resolved Tasks

Open Tasks(6) ~ Deferred Tasks (1) = Resolved Tasks (3) = HostAssets (Unique) (1) ~ QIDs (Unique) (10) ~ Approvals = Task SLAS
= ResolvedTasks Search Number v | Search <4< « 1 to3of3 » »r B
S Grouped vulnerability Task
8B Q =Number = State =prioity = Configuration item Host asset =aqQbD L i = Assi = Assigned to Detection event
Windows Server 2008 R2 Citical & Hiigh
@  viaske Resolved @ 1-Critical  demov — Vulnerability Routing (empty) Vulnerability Tasks by
vmdr Enterprise 64 bit... c
Windows Server 2008 R2 VMDR Windows Critical & iigh
@  viaske Resolved  ® 2-High demow e —— (empty) Vulnerability Tasks by
vmdr Enterprise 64 bit... Vulnerability Team
Critical & High
®  vaskoo Resolved @ 1-Critical  demoy r — Windows Server 2008R2 ooty (empty) Vulnerability Tasks by
vmdr Enterprise 64 bit... c
Actions on selected rows... v 1] to30f3
Open Tasks(6) ~ Deferred Tasks (1) = Resolved Tasks (3) = Host Assets (Unique) (1) = QIDs (Unique) (10) ~Approvals = Task SLAS
= HostAssets(Unique) Search Name v | search < < 1 to1ofl b br B
T qualys-ostassets
Configuration item Possible Cl Matches Last Vulnerability Scan Date Netbios Network Id
@  demow 1 1492 10. 2023-02-0121:48:00 DEMC 0
Actions on selected rows... v 1] tolof1
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QIDs

Open Tasks (6)  Deferred Tasks (1)  Resolved Tasks(3)  Host Assets (Unique) (1)~ QIDs (Unique) (10) | Approvals | Task SLAs

= QDs(Unique) Search Title v | search 1| tol10of 10 =

Y Qualys-KnowledgeBases

¥ QO =Qp  =Titea = Vulnerability Type Scategory  Severitylevel ~ Patchable = PCICompliance
6] EOL/Obsolete Operating System: Microsoft Windows Server 2008 R2 Detected Confirmed ulnerability Security Policy  ® 5-Critical false true
® EOL/Obsolete Software: Apache Tomcat 7.0.x Detected Vulnerability or Potential Vulnerability ~ Security Policy @ 5- Critical false true
(D EEER  EOL/Obsolete Software: Microsoft NET Framework 4 -4.5.1 Detected Confirmed ulnerability Security Policy  ® 5-Critical false true
® 6  EOL/Obsolete Software: Microsoft Internet Explorer 8 Detected Confirmed Vulnerability Security Policy  ® 5-Critical false true
6] EOL/Obsolete Software: Microsoft SQL Server 2012 Service Pack 2 (SP2) Detected Vulnerability or Potential Vulnerability ~ Security Policy @ 5-Critical false true
® EOL/Obsolete Software: Microsoft Visual C++ 2008 Redistributable Package Detected  Confirmed Vulnerability Security Policy  ® 5-Critical false true
6] EOL/Obsolete Software: Winamp Media Player Detected Confirmed ulnerability Security Policy  ® 5-Critical false true
® EOL/Obsolete Software: Wireshark 3.0 Detected Confirmed Vulnerability Security Policy  ® 5-Critical false true
6] ‘TeamViewer Desktop Privilege Escalation Vulnerability Confirmed ulnerability Local 4-High false true
® Windows Print Spooler Remote Code Execution Vulnerability Confirmed Vulnerability Windows 4-High false true

For the tasks to be grouped under a specific group, you can configure the detection rules
for vulnerability task groups in Qualys Core. Infrastructure and Security teams can view
all the tasks.

General Settings

You can define the default approval behavior for the exception management and false
positive reporting process.

For exception management and false positive reporting, you need three approvals - first
from the infrastructure/application group and two security approvals from security team
and security board. However, you can modify this to the customized approval.

Approval Configuration Default

The Approval Configuration Default tab | Infrastructure / Application Owner Approval
Defaults section, define the following fields:

— GeneralSettngs a
Filter navigator < = global [VMDR for ITSM General Settings view] &P S oo Update

Defaul -

W Knowledge Base:

Confirmed

Infrastructure / Application Owner Approval Defaults
A

'V Configuration c k " step

+ Infrastructure  App Owner Approval Type:
General Settings ’ Dol

Benchmarks o _user_group]

Content Taxonomy

Couchbase Cluster
Infrastructure / App Owner Approval Type | Vulnerabilty Task Field v
Interaction

/A | 1 v

Now Experlence Framework

Application Exception Approver - Level 1 allo

Qualys Core

Infrastructure / App Owner Approval Type - Select Vulnerability Task Field for the built-in
approval process based on the field value from a vulnerability task.
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Select Custom to disable the built-in approval step for Infrastructure / Application Owner
Approval.

Approval Group: Infrastructure / App Owner Task Field - Select a field to use as a default
for the Infrastructure Approval, when utilized.

Infrastructure/ App Owner Default Approval Group - Select the group to use for
Infrastructure Approval if the automated selection does not resolve to a valid group.

In the Security Approval Defaults section, define the group of users responsible for
security review of a vulnerability task.
Security Approval Defaults

Configure the groups of users that will be asked for approval during Security Review of Vulnerabilty Tasks

+ Approval Group: Security Team: This group of users will be asked for approval whenever a Vulnerability Task requires review by the Security Team.
« Approval Group: Security Board: This is the group of users whom will be asked for approval whenever a Vulnerability Task requires review by the Security Board

Approval Group: Security Team VMDR Security Team alle

Approval Group: Security Board VMDR Security Board alle

- Approval Group: Security Team - Group of users responsible for approval whenever a
Vulnerability Task requires review by the Security Team.

- Approval Group: Security Board - Group of users responsible for approval whenever a
Vulnerability Task requires review by the Security board.
Exception Process

In the Exception Process tab, select the template that should be used by default when the
state of the vulnerability task changes to Exception - Identified.

Approval Configuration Defaults |~ Exception Process | False Positive Process

Configure detalls regarding the Exception Process for Vulnerability Tasks.

- Template: Please select p lied ity Task when the state changes to Exception - dentified. NOTE: The template must only have the Exception Reason ield specified.

Template: Exception Identified EXAMPLE: Exception identified =SiNo)

You can select the template from the available templates or create a new template that
includes the exception reason.
False Positive Process

In the Exception Process tab, select the template that should be used by default when the
state of the vulnerability task changes to Exception - Identified.

Approval Configuration Defaults ~ Exception Process | False Positive Process

[ i forVulnerability Tasks.

- Template: ified: Please select the templ would like applied to y Task hanges t f NOTE: onlyhave i ifed

Template: Fal BAMPLE Fal dentified allo

You can select the template from the available templates or create a new template that
includes the exception reason.
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The remediation owners can seek exception for an individual vulnerability task or for a
vulnerability task group if the vulnerability cannot be remediated for various reasons,
such as, not enough downtime available, patch not available, or applications not

compatible with updates.

This section presents how a remediation owner can initiate an exception, inputs that
needs to added while requesting exception approval and the state of the ticket during
exception management. This section also presents how the approver can approve or reject

the exception requested.

Exception Initiation

To initiate an exception:

Go to VMDR Tasks or VMDR Task Groups > Assigned to My Group (Open).

Click an open task.

Right-click in the title bar, and click Exception - Initiate.

Fiter navigator

Number

VMDR Tasks Connector

Assigned to My Group (Open) Qualys Detection

Assigned to My Group (Fixed) Creston source

Assigned to Me (Open) Configuration item

¥ Exceptions

Class

Open Exceptions (My Groups) s

Open Exceptions (Assigned to Me) 5

Host Information
Pending My Approval
Operating System
Awaiting Approval (My Groups)
Cloud Resource D
Awalting Approval (Assigned ...
Assetid
Approved Exceptions (My Groups)
Qualysid
Approved Exceptions (Al)
Truisk Critcalty Score
Rojocted Exceptions (My Groups)
Truisk score
Al

< E= Qualys-VMDRTask-VTASK0000233

save
‘Add to Visual Task Board

VTASK000C Exception - Initiate

state
False Positive - Initiate
Launch VM scan Vulnerability Status
Metrics Timeline:

Severlty level
Follow on Live Feed

Show Live Feed

Automated - Qualys Integration Assignment group

Export >

Assigned to
Create Favorite

Copy URL QDS Severity

Reload form

~None~ Qualys detection score

Host Network Information

Centos Linux 731611 Pyt
[

Hostname

Netblos

FQDN

DNS Name

Domain

The State is changed to Exception - Identified.

In the vulnerability task, scroll down to the Exception tab.
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In the Exception tab, select Exception Business Risk and enter exception reason in the
Reason for exception.

¢ = Qe T # = e T

20230331 01:3312 -

2]
5]
m
L]
']

Exception recommendations

5
%
5
0l
B
L]
]
']

Click Approval Configuration tab, select the approval group in the Infrastructure/ App
Owner Approval Group.

{ = Qualys-VMDR Task-VTASK000 P oo NSRS  Exception - Request Approval N

TruRisk Criticality Score FQDN -
TruRisk Score DNSName
Domain

Exception  Approval Configuration | Vulnerabllity Detalls | Detection |~ Notes / Activity

Infrastructure / App Owner Approval VMDR Cloud Infrastructure Approvers e
Group

[LEESM Exception - Request Approval

Click Exception - Request Approval.
The State changes to Exception - Awaiting Approval.

The exception is submitted for approval. The approver group approves or rejects the
exception. See Exception Approval.

After the exception is approved or rejected, go to the task for which exception was
requested, and click VMDR Approvals tab.

You can view the approver and the state of exception approval.
Recent VM Scans for Host ~ Open Tasks for Host (405) ~ Open Tasks for Vulnerability (1) ~ Task SLAs (1) ~VMDRApprovals (3) ~ Vulnerability Task Groupings
= VMDRApprovals Search Approver v Search 1 to3of3 =]

Y vMoRApprovals

& Q = Approver =state = Comments = Approving = Group
[6) Cloud Application Owner ® Approved Qualys - VMDR Task: VTASK0000233 GAPRV0010048
@ Security Person Requested Qualys - VMDR Task: VTASK0000233 GAPRV0010049
@ Security Person Requested Qualys - VMDR Task: VTASK0000233 (GAPRV0010049
Actions on selected rows. v 1] to3of3
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You can also view the additional approvers after initial application infrastructure
approval. The other approvers need to follow the exception approval workflow.

If the approver rejects the exception, it reflects in the task record | VMDR Approvals tab.

RecentVM Scans for Host ~Open Tasks for Host (405) ~ Open Tasks for Vulnerability (1) | Task SLAs (1) ~ VMDRApprovals (2) = Vulnerabllity Task Groupings

= VMDRApprovals Search Approver v | Search 1 to2of2 =
2023-01-30 09:09:21 - curity Person
< (Comments)
¥~ VMDRApprovals This Is not something we can make an exception to,
& O = = soe as the vulnerabllity Is to critical and the business = =
N = Aoprover = system contains customer data. = Approving = Group
[6) Cloud Application Owner ® Approved Qualys - VMDR Task: VTASK0000232 GAPRV0010048
® Security Person ® Rejected 2023-01-30 09:09:21 - y Pers. Qualys - VMDR Task: VIASK0000233 (GAPRV0010049
Acti lected v 1] to20f2

Exception Approval

Once the exception is requested, the designated approvers or approver group members
can approve or reject the exception based on the business risks involved and reason for
exception. The following sections present the workflow for exception approval and
rejection.

The exception request could include three or four stages of approvers and can be
approved/rejected by any of the assigned group members.

Note: This workflow is available only for the approver groups.

Approval Workflow
Log on to the application and go to Qualys VMDR.

Click Exceptions | Pending My Approval.
The right pane displays the exceptions requested for approval.

Fiter navigator = Approvals Search State v | Search W 1] to1of1
(5 ¥ AU > Approvalfor Tasktypels a (Qualys - VDR Task, Qualys - VMR Task Group, Qualys - VMDRTask) > q > Approval for P! > Approver = Riley Cloud Application Owner
Eod Q, = state. = Approver = Comments = Approval for = Created
Qualys VMDR
(® - Requested (Cloud Application Owner VIASK0000233 20230130 04:47:47

'V Exceptions
Actons on selected row, v 1] tolofl
Pending My Approval

'V False Positive Requests

Pending My Approval

W Knowledge Base

Confirmed

Al

Click the State column.
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Approver

State

Comments

Activities: 1

Update | Approve | Reject | | Delete

Summary of Item being approved

Qualys - VMDR Task

Number
Connector
Qualys Detection

Creation Source

< == Approval - Qualys-VMDR Task: VTASK000

Cloud Application Owner @
Requested ~
Comments

System
Approver loud Application Owner

State  Requested

VTASK000

Qualys-POD 1 @

Automated - Qualys Integration

Approving
Qualys - VMDR Task
Number VTASK0000
Connector Qualys-POD 1
Qualys
Detection
Creation Source

Host Information
Operating
System

Cloud Resource
D

AssetId
Qualys Id

TruRisk
Criticality Score

TruRisk Score

Automated - Qualys Integration

CentOS Linux7.2.1611

B

Update

Qualys - VMDR Task: VTASK0000.

State
Approval

Vulnerability
status

severity level
Change request

Assignment
group

Assigned to
QDS Severity

Qualys
detection score

Approve | Reject | Delete

@

Open Record

Exception - Awaiting Approval
Requested

Active

'VMDR Windows Vulnerability Team

HIGH

Host Network Information

1Pva

1PV

Host name

Netbios

FQDN

DNS Name

Domain

™~ V4

The task record opens. In the task record, Exception tab, add dates and exception

recommendation,

and click Update.
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You are back on the approval record.

< == Approval - Qualys - VMDR Task: VTASK000

Approver

State

Comments

Activities: 1

Update | Approve | Reject

Summary of item being approved

Qualys - VMDR Task

Number
Connector
Qualys Detection

Creation Source

Click Approve.

Zloud Application Owner

Requested

Comments

system

Approver

loud Application Owner

State  Requested

VTASK000

Qualys-POD 1

Automated - Qualys Integration

Rejection Workflow

Approving
Qualys - VMDR Task
Number VTASK0000
Connector Qualys-POD 1
Qualys
Detection

Creation Source

Host Information
Operating
System

Cloud Resource
D

Assetld
Qualysid

TruRisk
Criticality Score

Trurisk Score

Log on to the application and go to Qualys VMDR.

Click Exceptions | Pending My Approval.

Automated - Qualys Integration

CentOS Linux7.3.1611

Qualys VMDR for ServiceNow

Vi VA eoc  update

Qualys - YMDR Task: VTASK0000!

State
Approval

Vulnerability
Status.

Severity level
Change request

Assignment
group.

Assigned to
QDS Severity

Qualys
detection score

Qualys VMDR

Approve | Reject || Delete

@

Open Record

Exception - Awalting Approval
Requested

Active

VMDR Windows Vulnerability Team

HIGH

Host Network Information

1Pva

1PV

Host name

Netbios.

FQDN

DNS Name

Domain

The right pane displays the exceptions requested for approval.

Filter navigator

Y’j‘*

Qualys VMDR
'V Exceptions
Pending My Approval
'V False Positive Requests
Pending My Approval
'V Knowledge Base
Confirmed

Al

= Approvals Search  State v

=state

® Requested

@ Requested

Actions on selected rows.

Click the State column.

Search

/Al > Approvalfor Task type s a (Qualys - VMDR Task, Qualys - VMDR Task Group, Qualys - VMDR Task) > =

= Approver

ecurity Person

Security Person

= Comments
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Click the icon besides the Approving field | Open Record.
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Approver

State

Comments

Activities: 1

Update

Summary of Item being approved

Qualys - VMDR Task

Number
Connector
Qualys Detection

Creation Source

Approve | | Reject | Delete

{ == Approval - Qualys - VMDR Task: VTASK0000;

security Person @
Requested ~
Comments
System
Approver 1Security Person

State  Requested

VTASK0000

Qualys-POD 1 @

Automated - Qualys Integration

Approving
Qualys - VMDR Task
Number VTASK000C™™
Connector Qualys-POD 1
Qualys
Detection

Creation Source

Host Information
Operating
System

Cloud Resource
D

Assetid
Qualysid

TruRisk
Criticality Score

TruRisk Score

Automated - Qualys Integration

CentOS Linux 7.3.1611

& A oo

Update

Qualys - VMDR Task: VTASK000(

State
Approval

Vulnerability
status

Severity level
Change request

Assignment
group

Assigned to
QDS Severity

Qualys
detection score

Approve | Reject  Delete

Open Record

Exception - Awalting Approval
Requested

Active

'VMDR Windows Vulnerability Team

HIGH

Host Network Information

Pva

1Pv6

Host name

Netbios

FQDN

DNS Name

Domain

82

The task record opens. In the task record, add reason for exception rejection in the
Comments field, and click Reject.

< == Approval-Qualys-VMDR Task: VTASK000

Approver

State

Comments

Activities: 1

Update | | Approve | Reject

Security Person ®

Requested v

This Is not something to, asthe

System

Approver Security Person
State  Requested

Delete

Approving

P A oo

Update

Qualys - VMDR Task: VTASK000(

Is to critical and the business system contains customer data.

Field changes -

A message is displayed that confirms the exception rejection.
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= Approvals Search  State v | search W 1 tolofl

® Rejected approval for Qualys - VMDR Task: VTASK0007 "™ X

T (5 ¥ AU > Approvalfor Tasktypels a (Qualys - VMDR Task, Qualys - VMR Task Group, Qualys -VMDR Task) > > Approval for P! > Approver = John Security Person
ualys

fod Q, = state. = Approver = Comment ts = Approval for = Created

¥ Exceptions
\IGRPOIS28 2002:111610:4028

Pending My Approval

Actons on selected rows. v 1 tolof1
'V False Positive Requests

Pending My Approval »

'V Knowledge Base

Confirmed

Al

False Positive

A remediation owner can mark a vulnerability task or a vulnerability task group as false
positive in a scenario where the vulnerability has already been remediated. The
remediation owner provides the reasons and required artifacts while confirming the false
positive request so that the approver team can investigate for request approval.

Once a vulnerability is marked as false positive, it goes through an approval process by
assigned approvers. If the false positive request is approved, no further action is needed. If
the false positive request is rejected, the remediation owner needs to follow the
remediation steps.

You can track the State of the vulnerability task and VMDR Approvals tab to understand
the status.

False Positive Initiation

To initiate a false positive request:

Go to VMDR Tasks or VMDR Task Group > Assigned to My Group (Open).
Click an open task.

Right-click in the title bar, and click False Positive - Initiate.
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{ = Qualys-VMDRTask-VTASK00O( ="~ P oo Follow |~ update N
save
Add to Visual Task Board
Number VTASKOO0O! Exception - Initiate State Open ~
False Positive - Initiate
Connector Qualys-POD 1 @ Laanch VM Scan Vulnerability Status Re-Opened

Metrics Timeline
Qualys Detection @ Severity level 4-High
Follow on Live Feed

Creation Source Manual Show Live Feed Assignment group VMDR Windows Vulnerability Team Qll®
Export >
Configuration item Assigned to Q
Create Favorite
Class Copy URL QDS Severity —None—
Reload form
Status —None - Qualys detection score
Host Information Host Network Information
Operating System FreeBSD 5.x / AlX 5.1-5.3 / MacOS 1Pv4
Cloud Resource ID 1P v6
Assetd Host name
Qualysid Netbios
TruRisk Criticality Score FQDN
TruRisk Score DNS Name
Domain

The State is changed to False Positive- Identified.

In the vulnerability task, scroll down to the False Positive tab.

— lys - VMDR Task -—
< = %]:s‘ﬁmn L2 j = oo Follow |~  Update [ESTSYSSHIEERIEW el Delote 'p \1,

False Positive | Approval Configuration  Vulnerability Detals  Detection  Notes /Activity

False Positive Reason =+
B I u ) Verdana ~  8pt - B~ A~ A - P 2 a B o
E == =2-&-%
Documentation required to capture reasons P
1. logs

2. screenshots

ol»li

IEESE False Positive - Request Confirmation [N

In the False Positive tab, enter a reason for marking this vulnerability task as false
positive.

Click Approval Configuration tab, and select the approval group in the Infrastructure/ App
Owner Approval Group.

mm=  Qualys - VMDR Task
= e # = - 1

Domain =

FalsePositive | Approval Configuration | Vulnerability Details  Detection  Notes / Activity

Infrastructure / App Owner Approval VMDR Cloud Application Approvers o|l®
Group

RES  Faise Positive - Request Confirmation IS

Click False Positive- Request Confirmation.

The State changes to False Positive- Awaiting Approval.
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The false positive request is submitted for approval. The approver group approves or
rejects the false positive request. See False Positive Approval.

After the false positive request is approved or rejected, go to the task for which false
positive request is sent, and click VIVIDR Approvals tab.

You can view the approver and the state of approval. You can also view the additional
approvers after initial application infrastructure approval. The other approvers need to
follow the false positive approval workflow.

Recent VM Scans for Host  Open Tasks for Host (17) ~ Open Tasks for Vulnerability (1)  TaskSLAS (1) ~VMDRApprovals(2) = Vulnerability Task Groupings

=  VMDRApprovals Search | Approver v | Search 1 to30f3 =]
S’ vMDRApprovals
b5 Q. = Approver = state = Comments = Approving = Group
® Zloud Application Owner © Approved Applic Qualys - VMDR Task: VTASK( GAPRV0010050
® serson Requested Qualys - UMDR Task: VIASK( GAPRV0010051
® Person Requested Qualys - VMDR Task: VIASKI GAPRV0010051
1 to3of3

If the approver rejects the false positive request, it reflects in the task record | VMDR
Approvals tab.

If all the approvers approve the false positive request, the state of the task changes to
False Positive - Confirmed.

= Qualys-VMDRTasks Search Number v | Search 1 t200f30 » PP

[ § Al > Acive=true > Assignmentgroup is (YMDR Remediation Owners 1, Windows Server support , Team Venus, VMDR Windows Vulnerabllity Team) > Number ends with 317

B QO  Shumbera Sstate  SPrioity = Configurationitem = Hostasset =iPv =qQD  =Tite =Assignmentgroup  SAssignedto = Opened
%317 search Search Search Search Search Searct Search search Search Search

VMware ESXI 3.5 Patch
False

® st Positive- 2-Hgh  (empty) iy ReleaseESKIS0- \MDR Windows i 20211101
- Confirmed S 20091240166 Missing  Vulnerabity Team 150531
(KBL016657)
Microsoft Splwows4
@ viasio Open - $odarte | e 3709 Windows Elevationof DR WIndous (empty) Lol
Privilege Vulnerability  “0er0llity Team 15:10:22
Exception- Birthday attacks against
: ) TLS clphers with 64blt  UMDR Windows 20211101
@ s AWGIES 53 Modorete] - Hempy) b 3mest block size vulnerability  Vulnerability Team (empty) 15:16:01
Approvat (sweet22)
Microsoft Internet
Exception - Explorer Multiple
@ s Awaiting 2-High (empty) L 5 100202 Remote Code Execution YMDR Windows (empty) AL
Team 15:16:55
Approval (Ms14-

035)

False Positive Approval

Once the false positive request is initiated, the designated approvers or approver group
members can approve or reject the false positive request based on the proofs provided.
The following sections present the workflow for false positive approval and rejection.

Note: This workflow is available only for the approver groups.

Approval Workflow
Log on to the application and go to Qualys VMDR.
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The right pane displays the false positive requested for approval.

[re—— = Approvals Search | State v | search W T o1ofi
() ¥ AU > Approvalfor Tasktypels a (Qualys - VDR Task, Qualys - VMR Task Group, Qualys - VMDR Task) > q > Approval for t firmat: > Approver = Riley Cloud Application
owner
QualysVMDR B O =sate = Approver = Comments = Approval for = Created
W Exceptions ® Requested Cloud Application Owner VTASKO0O! 2023.01-21 17:19:06

Pending My Approval

Actons on selected row.

'V False Positive Requests

Pending My Approval

'V Knowledge Base

Confirmed

Al

Click the State column.

Click the icon besides the Approving field | Open Record.

& == Approval-Qualys-VMDR Task: VTASK0000

Approver =" Cloud Application Owner
State Requested
Comments Comments
Activities: 1
System

Approver

Cloud Application Owner

State  Requested

Update || Approve | Reject | Delete

Summary of Item being approved

Qualys - VMDR Task

Number VTASK000C..

Approving
Qualys - VMDR Task
Number VTASK0000
Connector Qualys-POD 1
Qualys
Detection

Creation Source Manual

Host Information

Operating

1] tolof1

& - oeo update

Approve | Reject | Delete

Qualys - VMDR Task: VTASK000C @
Open Record
State False Positive - Awaiting Confirmatals
Approval Requested
Vulnerability Re-Opened
Status

Severity level 4-High

Change request

Assignment
group

VMDR Windows Vulnerability Team

Assigned to
QDS Severity

Qualys
detection score

Host Network Information

Pva

The task record opens. In the task record, False Positive tab to view the reason why a
remediation owner has marked this as false positive.
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You are back on the approval record.
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< == Approval-Qualys- VMDR Task: VIASK00OC ™ ~

State  Requested

Update | | Approve | | Reject | Delete

Approver Zloud Application Owner @
State Requested v
Comments Recorded as false positive. Confirmed.
Activities: 1
System
Approver Cloud Application Owner

A A oo update | Appove  Relect | Delete |,

a

Approving Qualys - VMDR Task: VTASK000C ®

Field changes - 2023-01-31 17:19:06

Click Approve.

A message is displayed that confirms the approval.

= Approvals Search | State v | search

.w.

‘ @ Approved Qualys - VMDR Task: VTASKOC

X

¥
Owner

s Q. = state = Approver

(5] 7 Al > Approvalfor Task typeis a(Qualys - YMDR Task, Qualys - VMDR Task Group, Qualys - VMDR Task)

No records to display

> Approval for iting C:

> Approver =Riley Cloud Application

= Approval for = Created

Alternatively, you can add a message and click Reject.
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Scan Executions

You can view details of all scans launched through ServiceNow here. The scans are also
categorized as pending scans and scans with errors.

You can view all the scans that you have initiated.

T Al
= * (S
& Q = Title = Scanner = Option profile = Executed by = Executed on = Scan Status = Integration status
W Scan Executions
Search Search Search Search Search Search Search
SRR . [SCNEXC0000003] launched
® L o launched o)\ owapp Testing 2008 SANS20 Options Nate Anderson 2021-102718:52:49  Finished Completed
from ven04911.s..
My Scans (Errors)
6] &“NEX@OMM lounched g0 app Testing Initial Options Nate Anderson 2021-102813:22:40  Finished Completed
My Scans (All) rom ven0491Ls..
. [SCNEXC0000005] launched
All Scans (Pending) ® Po— SNOWApp Testing Initial Options Nate Anderson 2021-10-28 13:35:39 Queued Error
All Scans (Errors) [SCNEXC0000006] launched o MOW- StdVM Scan - NoAuth- Waiting - For Other Status
@ fomvensanys. e — Fast-Web.. Check
AllScans
(D 1SCNEXCoooooo7)launched oy octing initialOntiens. David Gragnn. 211115061345 Einishad Comnlated

Click the options in the left pane to view required scan executions.

Detections

You can view details of all vulnerabilities detected by Qualys VMDR.

Qualys Qualys- Host Detections m Search  Number v | Search 1 to200f263754 B PP
= T A
oo O, =nNumbera =QD  ScConfigurationitem = QualysHost ~ SPot  SProtocol  EService  SVulnerabilityStatus  SFirstfound  Slastfound =S
W Detections Search searct | | Search Search search | | Search Search Search Search Search se
New
~ 2020-07-03 202007-03
()  HDETCT0273478 (empty) 1
. 00:47:08 00:47:08
Re-Opened
- 2020-07-03 202007-03
HDETCT0273497 t i 1
Fixed ® (emety) 1735550 173550

All

You can click the options in the left pane to view vulnerabilities based on its status, that is,
New, Active, Fixed, and Re-opened.

For each detected vulnerability, you can view vulnerability details, such as, detection ID,
type and status of vulnerability, results of the vulnerability and other details, such as,
host details, related knowledgebase, and scan dates.

Qualys Patch Management Workflow

With Qualys VMDR application, automatic change tickets are created to track the
remediation action for the detected vulnerabilities. The change requests can create

automated patch deployment jobs in Qualys Patch Management, which helps to reduce
risk faster.

Note: This application is available for remediation owners.
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The change management process included the following steps:

- When a vulnerability is detected, it is pulled in the Qualys VMDR with the detection
event rule and a vulnerability task is created.

- With a detection event rule for change requests, a new change ticket is created with
vulnerability details and Cls associated with it. This is applicable if the Cls are part of the
ServiceNow CMDB.

- When the change is approved, a deployment job is created withing ServiceNow and later
in the Qualys Patch Management.

- The job status and result will then be monitored, and the updates will be logged into the
change ticket under the deployment job.

- Once the job is created in Qualys Patch Management, the status of the change ticket is
updated.

- After the vulnerability is remediated and the next VM scan runs, it will close the
vulnerability task in ServiceNow and the change manager can then review the change and
close the change ticket manually

Change Request - Review, Assessment and Approval

In the application navigator, go to Change Request > New.

Click the change request in a New state.

¢ = ChomseReuen @ I IS oo Rlow - RequestApproval | Update |

AAAAAA Authorize Scheduled Implement Review Closed Canceled

v

L

Risk Moderate ¥
L v
d

Windows Patches for 0f2023.01-16

@

Planning | Schedule | Conflicts  Notes | Closure Information

al start date

B | 6

Plannedstartdate | 2023-01-1617:44:33 Actual end date

Planned end date CAB delegate

CABrequired CAB recommendation

In the Schedule section, set the Planned start date and Planned end date.
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The Affected Cls tab displays the CIs that were automatically added based on VMDR tasks
associated with this change request.

Affected CIs (2)  Impacted Services/Cls  Approvers  ChangeTasks  Problems | Incidents Fixed By Change  Incidents Caused By Change s Tasks (1177) | Qualys loyment Jobs
= | AflectedCis H search | Configurationttem v | Search <« < 1202 » bb @
S Tesk=cHosonrs
% Q= Configurationitem lass
@ Hardware
@ Hardware
Actions on selected rows. v 1 w20f2
AffectedCIs(2)  Impacted Services/Cls ~ Approvers  ChangeTasks  Problems  Incidents Fixed By Change  Incidents Caused By Change ly Tasks (1177) i I Jobs
Qualys-VMDRTasks  Search | Number v | search « < 1 ondm b e B
S Change request=CHG1802078
@& O Shumbera wate  Sproty = Configunationitem = Hostasset = =me Sasigmentgop  SAsignedto  SOpened = Detection event
- Microsoft VBScript
Engine Remote Code 2021-11-01
@ s Change e 2HEh et A pecution Vulnerabilty (empty) 150525 (empty)
e (Ms15-019)
Avalting Microsoftnternet I
@ Ve« Change ® 2-High (empty) 100335 Explorer Security Update (empty) ls-as- u‘ (empty)
Request for May 2018
Awaiting Microsoft NET P~
® mse Change @ 2-High ¢ a9 Framework securty (empty) o (empty)
Request Update May 2018
Awalting Microsoft Cumulative
Security Update for 2021-11-01
® s ® 2-High i s e isic. ; (empty) e (empty)
Request
o63)
Awaiting Microsoft XML Core
Services Remote Code: 2021-11-01
® s | Change ©2-High  (empty) 90852 ceecston ety (empty) i (empty)
Request
(Ms13-002)
In the State field, select Assess state, and click Save.
¢ | = ChangeRequest O = oo Follow  ~ | RequestApproval = Update /N
Save |
Copy Change ~
Cancel Change Save record and remain here
Ne  AddtoVisual Task Board Authorize Scheduled Implement Review Closed Canceled
——  Createoutage k
Propose a Standard Change Template
Refresh Impacted Services E‘-“ Model Normal Qe
Metrics Timeli | 1
etrics Timeline | T allo Type Normal v
Follow on Live Feed B
Show Live Feed Ither e State Assess “
Disable Scheduling Conflict Message £
Export > | Q Conflict status NotRun
View > a Conflictlast run
Create Favorite |}
o [  Assignment group Team Galactics alle
History > Biow % Assigned to Q
Reload form E
Risk” T Moderate e

The Qualys PM - Deployment Jobs tab displays the patch deployment jobs that are

created.

Affected CIs (2)  Impacted Services/Cls  Approvers (1) | ChangeTasks  Problems Incidents Fixed By Change
Qualys PM - Deployment Jobs  Search  Name v | search
T Task=CHG1802078
& Q Name status

(®  Windows Patches for 20230116 pending -Task Approval
(®  Windows Patchesfor” 50120230116 pending - Task Approval
(®  Windows Patchesfor 5020230116 pending - Task Approval
(®  Windows Patchesfor 150£2023-01:16 pending - Task Approval
(@  Windows Patchesfor 250120230116 Pending - Task Approval
(@  Windowspatchesfor 250120230116 Error
Actions on selected rows v

Incidents Caused By Change |~ Qualys -VMDR Tasks (1177)

Qualys PM - Deployment Jobs (6)

once

once

once

once.

once

once

2023.01-16 17:4433 Agenttime zone

20230116 17:44:33 Agenttime zone
20230116 17:44:33 Agent time zone
20230116 17:44:33 Agenttime zone

20230116 17:44:33 Agenttime zone

2023.01-16 1

3 Agent time zone

4 < 1

Qualys-POD1

Qualys-POD1

‘Qualys Demo Account

Qualys Demo Account

Qualys qg3 (vmdradsa)

t6of6 > b

Created

2023-02-1223:0924

202302.1223:0024

202302-1223:00:25

202302-1223:09:25

202302.1223:00:25

2023-02-1223:0925

1 to6of6

> B
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Note: A unique job is created for each connector. For each connector, up to 50 hosts
can be added to one patch deployment job.

Review Patch Jobs with Errors

Click the patch job with error state to view the job details.

Click the Log tab to review the possible errors. The possible cause of the error is some or
many hosts that do not have UUID value required for patch deployments.

Qualys PM - Deployment Job

< == Windows Paiches for 250120230116
Name | Windows Patches for
Number | DPLYIOB
Qualys-Job D
Task | cHolt
Connector | Qualys qg3 (ymdradsa)

Configuration  Patches Information | Log.

Activities: 7

as0f2023.01-16

Status

Start Date/Time

PN E

Error

20230116 17:4433

pdate  [SCHTTLANGIRIRN  CreatePatchob AN

Log - 2023021223:0926

Create Patch Jobj - EXCEPTION THROWN in

}-resp.
}- EXCEPTION

Status  Ermor was API Call n Progress - UUID Check

Status  API CallIn Progress - UUID Check was Queued -UUID Check

Status  Queued -UUID Check was Error

Field changes + 2023

0212220926

Field changes + 2023.02-122309:25

Field changes + 20230212 230925

Scroll down to view the entries indicating that have no UUID in ServiceNow stored for the

host.

You can perform two actions:

- To ignore a specific entry for patch deployment, right-click the entry, and click Cancel -
Ignore. To ignore multiple entries, select the corresponding check boxes, and select Cancel
- Ignore from the list of available action.

= Jobltems Search Number

S Job=wWindows Ptches for 1

v search

50f2023.01-16

& O SNumbera = HostAsset = Qualysuu
® oewm demowin
O bpLvil demov
@© o oM

=qos

370446, 90829, 100232, 91634, 91254,
90740, 91038, 91495, 100114, 91682,
375718, 91674, 120274, 91653, 121843,

370427, 372247, 121279, 372020, 91560,

374531

100413, 373156, 100359, 91408, 91182,
91405, 91099, 370297, 91461, 100381,
91151, 91333, 91449, 01758, 91481,
91385, 91359, 100317

91485, 100399, 100408, 91353, 91771,
91443, 91563, 91453, 91605, 100412,
100359, 91591, 91340

= pctual start

(empty)

(empty)

(empty)

= Actualend

(empty)

(empty)

(empty)
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Error - No UUID
Foundin
ServiceNow

Error- No UUID
Foundin
ServiceNow

= stuscode

= failed patches

Show Matching
Filter Out

Copy URL toClipboard
AssignTog

Cancel- Ignore

YLRow

1 nRof12 a8

=installed patches = Success patches

>
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- Check whether UUID or patching is enabled on the host since the job was created or after
the hosts were last imported into ServiceNow. Click Check UUID in Qualys.

— QualysPM-Deployment Job =
< [[= Qaberm - Detory e @ V5 oo Update [ESTIDERLEURN  createpatchiob |
for: 5 -
Name | Windows Patchesfor 50120230116
Number | DPLYIOBOD Status | Queued- UUID Check
Qualys- Job D StartDate/Tme | 202301-1617:44:33
Task | cHoL ®
Connector | Qualysqg3 I
Configuration | Patches Information | Log
Platform | Windows. Scheduletype | Once
Opportunisticdownloads v/ Timezonetype | Agenttime zone
update | [ ROl | createpatch Job.
= Jobltems Search | Number v | seach 1 to12of12 ]
7 Job=Windows Patches for Team Galactics as of 2023-01-16
© O Shumbera SHosthsset Squbsup = qos Shcwslsar Shcuslend = Sttus SSutscode  Sraledpatches  Sinstalledpatches = Success patches
Ertor-No UUID
© e demown (empty) (empty) Foundin
370427, 372247, 121270, 372020, 91560, ServiceNow
374531
‘ Error-No UUID
® oem demowin e T (empty) (empty) Foundin
91385,91359, 100317 Seictow

When checking UUID in Qualys is completed, the status changes either to Pending - Start
Date or Pending - Task Approval based on whether the task (Change Request) has been

approved or not.

Navigate back to your change request > Approvers tab, to review the approvals needed and

approve it.

Affected Cis (2) | Impacted Services/Cls  Approvers (1)

Approvers  Search  State v | search

5 Approval for = CHG180.

Change Tasks

& Q =sue = Approver
® - Requested
Actonson selected rows. v

= hssignment group

Team

Problems  Incidents Fixed By Change  Incidents Caused By Change  Qualys-VMDR Tasks (1177) Qualys PM -Deployment Jobs (6)

= comments

1 tolofl B

= Created

2023021223:0921

1] olof1

Add to Upd

= Actions on selected rows...
Calculate R Add to Update Set

a

Create Application File
‘{ Assign Tag:
Now Intelligence
| Governance, Risk, and Compliance
Customer Service:
IT Operations Management

| Request Approval
Affected  YALA Show Matching Checked
Newtag
Customer Service Management
Performance Analytics and Reporting
IT Service Management
Software Asset Management
More...

J |8 o

<

Remove Tag:
Actions on selected rows... v

-

Select the check box for the approver, and click Approve from the list of available actions.

The change request is approved and the state changes to Scheduled.
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View Patch Deployment Jobs in Qualys Patch Management

You can view the status of patch management job in Qualys Patch Management
application.

Go to the patch job item, and in the Configuration tab, click View in Qualys.

= QualysPM-Deployment Job

< | = Quyze-vepio @ VS oo Updie  Refishsaus 0 |
.|
Name ‘Windows Patches
Number | DPLYIOBOC Status | Waiting -For Next Scheduled Status Check |
Qualys - Job ID 8197a91f- Start Date/Time 2023-02-23 17:47:03
Task CHGLE 6]
Connector | Qualys Demo/Account ®

Configuration | Patches Information | Log

Platform | Windows Scheduletype | Once

Opportunistic downloads |/

Update | | Rrefresh status | [RVSMTIVEIS

Timezonetype | Agenttimezone

Note: If the View in Qualys button is not available:
- Qualys Job ID is not populated and there is no job in the Qualys application.

- The connector is not configured with Web Portal URL. See Configure Connection to
Qualys Applications.

You are redirected to the Qualys Cloud Platform > Patch Management application > patch
job.

C @ qualysguard.[gi | [pm/#fjobs]
@ Qualys. cic
<— Job Details: Windows Patches Vulnerability Team

VIEW MODE

=3
b3

Basic Information

Basic Information

Assets
2 Windows Patches Vulnerability Team

Pre-actions
Job Status: Enabled | Job Type: Install
Patches

Post-actions

Options

Job Access <

Identification

Description GuiD Owned By
Windows Patches Vulnerability Team 0 quays2nh56
Scheduled Timezone Patch Window
Once, Feb 17,2023 01:46 am Default Agent Timezone None

Created on Modified on

Next Schedule
Feb 7,2023 11:05 PM

Feb 17,2023 04:16 AM
Runs in 2 days 6 hours 27 minutes 40 seconds
Show All.

If you have not logged on to the application already, log on to Qualys Cloud Platform.
Then, go back to the patch job item, and click View in Qualys. You are directed to the
patch job in Qualys.
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Create a new patch job manually
A remediation owner can also create a patch job in the Change Request.
Go to Change Request > Open, click a change request in Assess or Scheduled state.

In the Change Request > Qualys PM - Deployment Job, open the job in Error status.

¢ = QualysPH-Deployment Job
= w

indows Patches for 20230116 R [ | Criepaich kb v
Name | Windows Patchesfor 1 asof 20230116
Number | DPLYJOBIX Status | Eror
Qualys-Job 1D StartDate/Time | 2023-01-231800:00
Task CHG1805324 ®
Connector | Qualys-POD1 ®

Configuration | Patches Information  Log.

Platform | Windows Scheduletype | Once

Opportunistic downloads [/ Time zone type Agenttime zone

Update || Create Patch Job

In the Configuration tab, click Create Patch Job.

Once the job is created, the state of the deployment job changes to Waiting - For Next
Scheduled Status Check, and the Qualys Job ID is updated.

¢ | = QualysPM-Deployment Job

Number DPLYJOBOI g sttus Waiting - For Next Scheduled Status Check
 Qualys- Job 1D Tb0b307 Start Date/Time 2023-02-2317:46:53
Task CHGL ®
Connector Qualys Demo Account ®

Configuration | Patches Information  Log

Platform | Windows Scheduletype | Once

Opportunisticdownloads [/

pdate | [SISHUTLEROTENR | Create Patch Job

Time zone type Agent time zone

The state and patch information for each job item is updated periodically (every 4 hours)
by the automated status checking.

Refresh the Patch Job Status

To refresh the patch job status manually, go to the patch job item, and in the
Configuration tab, click Refresh Status.

¢ | == QualysPM-Deployment Job
= w

Name | Windows Patchesfo 50120230116

Number | DPLYIOB: Status | Walting - For Next Scheduled Status Check

Qualys-JobID | cTbsbsas: StrtDate/Time | 2023-012017:44:17

Task | cHels ®

Connector | Qualys Demo Account ®

Configuration | Patches Information  Log
Platiorm | Windows Scheduletype | Once
Opportunistic downloads [/ Timezonetype | Agenttimezone

Update || Rrefresh tatus m
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The system refreshes the status at a regular interval automatically. Once a particular
percentage (Configured in the General Settings of the Qualys Core application) of patch
deployment jobs items are completed, the status of the patch job changes to Complete or
Complete - Partial depending on the number of items completed.
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Reports and Dashboards
Go to Qualys VMDR App > Overview.

Qualys VMDR for ServiceNow
Qualys VMDR
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The Overview page displays a consolidated view of all the reports for vulnerabilities,

detection, hosts, and so on.
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The Qualys - VMDR- TruRisk tab displays the reports based on the VMDR TruRisk score.

= 89 Qualys-VMDR v + & =
Overview | Detections | Sths
Detections by Type Total Open Deteetions - Severity 445
1-Negigible=156652
0%
W omiuiiong W cootmed=sossaam I potentals 6T (1EI)
Detections - Found Last 30 days
H
% 1500
= oo
H
]
Ry & ® & s > & ® A » & 5 $ # & # 0 # S = > #
& # & & ta & e e 5 e ) s & s s o & 5 5
+ & & b + b Ed + & + + td L & + L & & + L
Group by [Hone =]
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The Detections tab provides reports on detections based on different criteria, such as, type
of detections, status of detections, number of detections.

= 89 Qualys-VMDR ¥
Overvew | Detections | SiAs
Active Breached SLAS AtRisksLAs

SLAAverage Age

1-Megliible-156.682

203 16,:)49 58 Days 9 Hours 45 Minutes

Active SLAs SLAs Breached (By Assignment Group)

iml III
- o

Active SLAs (By Assignment Group)

et CiasaBiNn

lnerabily Task LA Count

W Reopened = mpoges u Team = 112(55.37%)
v v Tl ‘

[Ens— r—— s Seertesm et

SLAs Average Age (By SLA) Average SLA Age (By Vulnerability Task State)

‘mpv_ g o o=
H
s | —
H
H
H 23 Days 3 Hours 13 Minutes.
- 2 & - > & 2
P & [ —_—
& & & o o & & s - O N o .
e B & § &8 frf & &8 a s &
& &
[P — PR L

The SLAs tab provides reports on SLAs based on different criteria, such as, active SLAs,
SLAs for each assignment group, average age of SLAs, and so on.

You can edit the existing dashboard, add new reports to the dashboard or create a new
dashboard.

Create a new report

You can create new reports for the data that you want to view. For example, report for
open tasks for a specific vulnerability type. You can also select the format in which the
data is presented, that is, bar chart, pie chart, time series, and so on.

To create a new report, in application navigator, go to Reports > Create New.

< Create a report

= Data > >k Report Title :
R %k Reportname
Getting Started
View /Run * sourcet Create your report with Analytics Q&A
ource type
Create New Data source v Ask for information. You can give simple filtering
conditions.
pladeioe sin s % Datasource You get the answer with an appropriate
Summary Sets No data source selected v visualization.

On-Call Scheduling

W Reports
Overview
How can | improve my results?

My Schedule Report

Schedule Report

(©)
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In Create a report > Data, enter the required details for a new report.
Report name: Provide a name for the new report.
Source type: Select Table from the list that is used as a source of the data.

Table: Enter Qualys to populate the Qualys import tables and select the relevant table
from the list.

< Createareport a s - [N

= Data > Type > Configure > Style ¢ >k ReportTitle : Log4j New
Reports >k Report name Table: Qualys - Vulnerability Task [x_quals_vmdr_vuln_task]
j A4
Getting Started Logd] New y Al
Create your report with Analytics Q&A
View /Run >k Source type y p y Q
Table v Ask for information. You can give simple filtering
Create New .
conditions.
Header Footer Templates >k Table You get the answer with an appropriate

Qualys- Vulnerability Task [x_qual5_vmdr_vuln_t... ¥ visualization.

Summary Sets

Description

On-Call Scheduling

Thereis no description for this table. To add a description,
W Reports please contact your admin.

Overview How can | improve my results?

My Schedule Report

Click Next.

In the Type form, select the way in which you want to present the report. For example, bar
chart, pie chart, time series report, and so on.

£  Createareport i) Save w “
Data > Type ) Configure > Style ¢ >k ReportTitle : Log4j New

Filter the visualizations El What do you want to see? Ask How can | improve my results?

To modify the current report, use the left panel or Edit Condition.

Bars
Compareindividual or aggregate scores across data Table: Qualys - Vulnerability Task [x_qual5_vmdr_vuln_task]
dimensions.
T Al
I I I Log4j New
Number State Severity level Priority IPv4 A Vulnerability Status Assignment group Assig
|II|I 2- wul bilit;
- (©  VIASK0189381 Open 4-High _ Active ulnerability e
High Routing
|
| -
@®  vIasko1seerz O 3- Medi 3 Acti Vulnerability (
en - Medium ctive e
pack Next P Moderate Routing =
» -

Click Next.
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In the Configure form, the fields that are displayed depend on the type of report that you
have selected.

By default, the report is created in a tabular format. In the following image, you can see
the options for configuring your report in a tabular format.

{ Ccreateareport ] Save ¥ “

Data > Type ) Configure >  style G K ReportTitle : Logaj New
Choose columns @ El /hat do you want to see? Ask How can | improve my results?
Group by To modify the current report, use the left panel or Edit Condition.
- None — v

Table: Qualys - Vulnerability Task [x_qual5_vmdr_vuln_task]
Additional group by

oA
]
Log4j New
Number State Severity level Priority IPv4 & Vulnerability Status Assignment group Assig
2- Vulnerabilit
(@  viAsko1se381 Open 4-High } Active ulnerabilty (el
High Routing

@  vrskoissers o 3- Medi 3- Acti Vulnerability .
en - Medium ctive e

In the right pane, all the data from the selected Qualys table is displayed.

For example, in this image, all tasks from the Qualys Vulnerability Tasks table are
displayed irrespective of the vulnerability status.

Click Edit Condition to filter the data for which you want are creating a report.
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Define the criteria to filter the data for creating a report. You can use single or multiple
attributes and filters.

-
< Create a report rT_'I Save v “

-

Data » Type ) Configure > Style ¢ >k ReportTitle : Log4j New

Choose columns 6] (=1 Whatdo youwantto see?

How can | improve my results?
Group by
_None — - To modify the current report, use the left panel or Edit Condition.

Additional group by Table: Qualys - Vulnerability Task [x_qual5_vmdr_vuln_task]
T A
Add Sort Clear Al X

¥ CONDITIONS
All of these conditions must be met

- choose field - ¥ ~ @ OR ‘ AND ‘

or

New Criteria

D> RELATED LIST CONDITIONS @

For details on how to define conditions for a report, refer to the Define Conditions.

Click Next.
In the Style form, select the style for your report.

< Create a report @ |-_1"| @[ Save @ w “

-

Data » Type » Configure »  Style ¢ K ReportTitle : Log4j New i
Title (=) Askanother question
Default color Black ol ® Table: Qualys - Vulnerability Task [x_gual5_vmdr_vuln_task]

Edit coloring rules ? All > Qualys Detection Vulnerability Status in (New, Active, Re-Opened) =

Qualys Detection QID QID in 87482, 87483, 376415, 376417, 376425, 376391, 240078, 376406, 20245, 240059, [...]

Display zero Y4
Add Sort Clear All X
Drilldown view Q,
‘W CONDITIONS
All of these conditions must be met
Qualys Detect... ¥ | isoneof v New - @ OR ‘ AND ‘
Active .
Re-Opened
Fixed .
AND
QualysDetect... ¥ | isoneof ~ 87482, - @ OR ‘ AND ‘
87483, o —
376415, P
or
New Criteria

Back
oo R p——

Click Run to apply the defined the condition.
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Click Save to save the report.

Define Conditions

In this example, you can see how to add the conditions for filtering tasks logged for Log4j
vulnerability, where the vulnerability status is are New, Active or Reopened.

- Select and expand the Qualys Detection table, and select Vulnerability Status field.

Table: Qualys - Vulnerability Task [x_gqual5_vmdr_vuln_task]
? All
Add Sort Clear All X
¥ CONDITIONS
All of these conditions must be met
Qualys Detect... ¥ v @ OR ‘ AND ‘
O\ Qualys Qualys Detection —» Qualys Detection Fields
© upspetecton @ S “B
Results
| 2
- Service
SysID
Tags
Times found itatus Assignment gri
Type
Updated
paa Vulnerability
Updated by Routing
Updates
Vulnerability Status -
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- Select the operator and appropriate values.
Table: Qualys - Vulnerability Task [x_qual5_vmdr_vuln_task]
<ol
D
Add Sort Clear All X
W CONDITIONS
All of these conditions must be met
Qualys Detect... ¥ is one of v New - @ OR ‘ AND ‘
Active
Re-Opened
Fixed .
or
New Criteria
P RELATEDLISTCONDITIONS @
- Click AND to add another condition.
- Select and expand the Qualys Detection table, and select QID.
- Select the operator and add all QIDs for log4j vulnerability.
Table: Qualys - Vulnerability Task [x_qual5_vmdr_vuln_task]
? All > Qualys Detection Vulnerability Status in (New, Active, Re-Opened) >
Qualys Detection QID QID in | . 3 ) 4 J ) 4 I 3, [...]
Add Sort Clear All >4

W CONDITIONS

All of these conditions must be met

Qualys Detect... W is one of v | New - @ OR ‘AND‘
Active —_—
Re-Opened
Fixed -
AND
Qualys Detect... Ww is one of v || -, = @ OR ‘AND‘
EFpRS, v —
— - _5, #
or
New Criteria

P RELATEDLISTCONDITIONS (@
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The filter conditions are added. Click Run to apply the conditions.

Add a Report to Dashboard

Once you add a report to the dashboard, you can view the report in the in the Overview
and track the change in the report data at a glance.

For example, if you add a report for active tasks for a specific vulnerability count to the

dashboard, you can track whether the count shows increasing or decreasing trend.

To add a report the dashboard, go to Overview, click Add Widgets icon.

Qualys - Host Detection Count

= B9 Qualys-VMDR v + B =
Overview = Detections = SLAs Add W|dgets x
Vulnerability Status Detection by Severity Widget Category
k
1 Favorites v
@
&
& )
150k v\k Q_ Filter
o A SLA Age (B) ;
B 125k ﬂ),v‘“b II. V:fnr:F:bilingilES{ale) )
g
3
_é 'p‘\"f I CISA Known Exploitable Vuln )
g
:9_; #% (Critical vuln Data >
3 v
< # HighVuln Data >
&
6,0‘ I Log4j New >
L
Click the report to be added and click Add.
= BB Qualys-VMDR ¥ + H =
Overview = Detections = SLAs ( Widget x
Vulnerability Status Detection by Severity
175k Log4j New
@
&
150k '\)@}
o
&
125k "lzﬁ“\
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B8 Qualys-VMDR ¥

QOverview | Detections | SLAs

Log4j New

Vulnerability Status

200k

Detection by Severity

—
@
=3
=

100k

Qualys - Host Detection Count.

@
=
=

-

You can resize the widgets and move the positions of the widgets in the dashboard.

You can update the presentation data presented in the report that you have created.

For example, in the Vulnerability by Port report, data can be grouped by Qualys Detection

Port, Detection Protocol, or Detection Vulnerability Status.

= B8 Qualys-VMDR v

Overview = Detections | SLAs

Vuln by Port
1500

1250
1000

750

500
250 I I
. I II
EI I
K

Qualys - Vulnerability Task Count

I- -I Nl e o e
& K& ¢ »
of

> o 5@ o o &
RO K¢ L R
M Active B New Re-Opened
Group by | Qualys Detection Port v | Stacked by ‘ Qualys Detection Vulnerability Status v ‘

Qualys Detection Port
Qualys Detection Protocol

Threat Intel Qualys Detection Vulnerability Status

= @ =
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Share the report

Once you add a report that you have created to the dashboard, only you can view it on the
dashboard.

If you want the report to be visible to a user or group of users, you can share the report
with other users. For example, a report on open tasks for a specific vulnerability can be
shared with the respective remediation team.

To share a report or dashboard with a user, go to Overview, click the Sharing icon.

= B8 Qualys-VMDR ¥ -~ =
Overview | Detections = SLAs w

4|
Log4j New CISA Known Exploitable Vuln

14 1,735

In the Share form, add a user name in the recipients, and click Share.

= B8 Qualys-VMDR ¥ +

2
Tt

Overview = Detections = SLAs < Share x

Log4j New CISA Known Exploitable Vuln To:

Add recipient

14 1,735 ...

MESSAGE
Vuln by Port

1500
1250

1000

Recipients Canview v

500 I I Cancel “

You can select the Send an email invitation to send an email notification to the selected
user, and add a message for the user. In the Recipients list, you can select the permissions
for the user to indicate whether the user should have view or edit permissions to the
report.

Qualys - Vulnerability Task Count
e
2
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You can view Qualys KnowledgeBase in the Qualys VMDR application.

Qualys-KnowledgeBases  Search Severitylevel ¥ | Search

[
= ? All>Vulnerability Type = Confirmed Vulnerability
Q, =qb =Title = Vulnerability Type = Category = Severity level A
W Detections Search Search =Confirmed Vulnerabili | Search Search
e - SUSE Enterprise Linux Security update for
167919 Confirmed Vulnerability ~ SUSE 1- Negligibl
(O] strongswan (SUSE-SU-2015:1196-1) onimecinemly, egloie
Active
. Euler0S Security Update Euler0S-SA-
@ s Uler0S Securty Update forlrss) Enler Confirmed Vulnerability  Euler0S 1-Negligible
2021-1803)
Re-Opened
@ usms Fedora Update for ssmtp (FEDORA-2010-11836)  Confirmed Vulnerability ~ Local 1-Negligible
Fixed
~ User Ac its With P: rd A Not Set
" @ 105083 (;:;r:;::;)s RO Age oty Confirmed Vulnerability ~ Security Policy 1-Negligible
W Hosts / Assets @  s0ser E:iﬁ;@)(“”‘yu"da'e'°'(“"‘E““'°5'SA' Confirmed Vulnerability ~ Euleros 1-Negligible
Al Netscape Enterprise Server Internal IP
@ s Address/Internal Network Name Disclosure  Confirmed Vulnerability ~ Web server 1- Negligible
CI-Matched Vulnerability
L @© 33008 IBM AIX Vulnerabilities inIpd (Ipd_advisory)  Confirmed Vulnerability  AIX 1-Negligible
W Knowledge Base @ 105 C::g:ﬁ‘f;mw“”ge WebRootDisclosure ¢ od Vulnerability €6l 1-Negligible
Confirmed -
@© 9003 IPInsight Installed Confirmed Vulnerability  Windows 1-Negligible
Al
@© o095 Cydoor Installed Confirmed Vulnerability ~ Windows 1-Negligible
Vuln Task SLAs
GN 170364 Debian Security Update for tinyproxy (DLA Confirmod \iulnoeahilit Dahian. 1 Nalinihla

1

= Patchable

Search

true

true

true

false

true

false

true

false

false

false

Qualys VMDR

t0200f 62477 B PP

= PCI Compliance

Search
false
false
false
false

false
true

false
true
true

true

You can click the options in the left pane to view knowledge base items for the confirmed

vulnerabilities, all vulnerabilities and SLAs for all vulnerability tasks.

=  Vulnerability Task SLAs  Search Number v

@ = Number = Qualys Detection

Qualys Host =QiD = Title = Business elapsed time
Search Search Search Searct Search Search
HTML Help

ActiveX
Control Could

1

@ VTASK0015743 HDETCT0666840 g il Allow Remote 90 Days 15 Hours 13 Minutes

Code
Execution
(MS07-008)

Oracle Java
SE Critical

@ VTASK0016799 HDETCT0438091 Patch Update 90 Days 14 Hours 45 Minutes

- October
2018

Microsoft
Internet
Explorer

@ VTASK0105376 HDETCT0506389 Cumulative 90 Days 13 Hours 42 Minutes

Security
Update
(MS14-065)

Google
Chrome Prior
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= Active

Search

true

true

true

= Actual start

Search

(empty)

(empty)

(empty)
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Debugging and Troubleshooting

How to debug

In case of any unexpected application behavior, you can check the application logs. The
application log has four different levels of logging: Information, Error, Warning, Debug.
The application writes log entries after important transitions.

Configure logging

From the Qualys Core application, click Diagnostics > Logging Configuration. In the Qualys
for ServiceNow Logging page, select Debug in the Logging Level field.

Qualys core System Configuration

Qualys for ServiceNow Logging
Logging Level

=

Qualys Core
P> Configuration Debug v
R Caalipat Max Cumulative Log Entries

P Import Row Tables

; 200
» Data Tables
W Diagnostics Max Cumulative Log Size
Logging Configuration
20000
Advanced Logging Configuration
Save

TypeScript Definitions

View Logs
To view the logs, navigate to System Logs > All, and filter with Qualys Core as App Scope.

= Appl_ggm Search Created v | Search | 1 toofL0T B PP

= ? All>Created on Today> App Scope Name starts with Qualys Core
& Q, = Created = Level = Message = App Scope = Source Script
Search Search Search Qualys Core Search

[0000001] - INFO: {SchedDatalmp.JobUtls : preSeript} - ENTERING

[0000002] - DEBUG: {SchedDatalmpJobUtls : preSeript} - bd83caa3sTL: [
[0000003] - DEBUG: {SchedDataimp JobuUtls : preSeript] - cance: false

[0000004] - DEBUG: {SchedDatalmp.JobUtls : preScript} - data_source: [object GlideRecord!

[0000005] - DEBUG: {SchedDatalmp JobUtls:: preScript] -import_set: [object GlideRecord]

(0000006] - INFO: {DataTransferChunkHelper  initialize} - ENTERING/EXITING

[0000007] - INFO: {ImportDefi per : getFirstActiveDefi Thread) - ENTERING

[0000008) - DEBUG: itionHelper : ge Thread} bd83caa3871374507bb3ad6e0ebb:

( ]- INFO: Iper : getF finitionUsingSchedDatal Thread) - Query():

active= port._threadsCON 1374507bb3: 542

(0000010} - DEBUG: Iper : getFirstActi “Thread] - Definition record was found

[0000011] - INFO: initionHelper : getFirstActiveDefiniti Thread} - LEAVING

[0000012] - INFO: {scl JobUtls : prescript} - Found ord: true

[0000013] - INFO: {SchedDatalmpJobUtls : getGRQueryObiectForAssociatedScheduledDatalmports] - ENTERING

[0000014] - DEBUG: {SchedDatalmp JobUtls : getGRQueryC jated - definition: [object

(0000015] - DEBUG: JobUtls i i - res.getEncodedQuery() )

@ ﬁ Information  sys_idiNbd83caa3871374507bb3a86eOebb3542 active=true Qualys Core ﬁ%w

= [0000016] - INF buUtls : getGRQueryObj Datalmports] - LEAVING = =

[0000017] - INFO: {DataTransferJobHelper : getActive JobForDefinition} - ENTERING

[0000018)] - DEBUE: [DataT: gethctive. defi fobject GlideRecord]

[0000019] - INFO: {DataTransferJobHelper : getActive ition] - Found no active jobs

[0000020] - INFO: {D:  getactive. ition] - LEAVING

[0000021] - INFO: {SchedDatalmpJobUtls : preScript} - No active job was found
[0000022] - INFO: {SchedDatalmpJobUtls : preScript} - Major Decisions in this Execution:

"Working with definition record: true”,

“No active job was found. Exit and Slow the Threads Down."
1
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Known Issues

FIM API does not support the 'updatedDate' filter. Hence, currently Qualys Core app can
not show the state transition of the synced incident on the Qualys UL
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